
ภ า ษ า ไ ท ย

โกวิท ป ระวาล พ ฤ ก ษ ์. แฟ ้ม ส ะส ม ผ ลงาน  (P ortfo lio ). ก ร ุง เท พ ม ห าน ค ร : ส ำน ัก งาน ก าร ศ ึก ษ า 

เอกชน  กระท รวงศ ึก ษ าธ ิการ , 2 5 4 0 .

จ ิน ต น า เล ็กล ้วน . ผ ล ข อ งก าร เร ีย น แ บ บ ร ่ว ม ม ือ ท ี่ม ืต ่อ ผ ล ล ้ม ฤ ท ธ ี้ท างก าร เร ีย น ว ิช าค ณ ิต ศ าส ต ร ์ 

และแรงจูงใจใฝล้มฤทธิไรiอ ว ิช าค ณ ิต ศ าส ต ร ์ข อ งน ัก เร ีย น ช ั้น ม ัธ ย ม ศ ึก ษ าป ีท ี่ 1 .

ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ าม ห าบ ัณ ฑ ิต  จ ุฬ า ล ง ก ร ณ ์ม ห า ว ิท ย า ล ้ย , 2 5 4 1 .

ช ัย พ ฤ ก ษ ์ เส ร ีร ักษ ์ แ ล ะค ณ ะ . “ก ารป ระเม ิน ผล โด ยใช ้แฟ ้ม ส ะส ม งาน  (Portfo lio  A s s e s s m e n t) "  

สส วท . 2 5  : (ก รก ฎ าค ม  -  ก ัน ย าย น  2 5 4 0 ) 1 3 - 1 5 .

ช ัย ฤ ท ธ ิ้ ศ ึล า เด ช . ก า?พ ัฒ น าแ ฟ ้ม ส ะ ส ม งาน ใน ก าร ป ร ะ เม ิน ผ ล ก าร เร ีย น ว ิช าภ าษ าอ ังก ฤ ษ ร ะ ด ับ  

ช ั้น ม ัธ ย ม ศ ึก ษ าป ีท ี่ส าม . ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ าม ห าบ ัณ ฑ ิต  จ ุฬ า ล ง ก ร ณ ์ม ห าว ิท ย าล ัย , 

2 5 4 0 .

ถน อมพ ร เล าห จร ัส แล ง. “อ ิน เตอ ร ์เน ็ต  : เค ร ือ ข ่า ย เพ ื่อ ก า ร ศ ึก ษ า ” ว าร ส ารค ร ุศ าส ต ร ์. 26  : 

(พ ฤ ศ จ ิก าย น  2 5 4 0  -  ก ุม ภ า พ ัน ธ ์2 5 4 1 ) 5 5  -  66 .

บ ุญ เช ิด  ภ ิญ โ ญ อ น ัน ต พ ง ษ ์ “Portfolio  A s s e s s m e n t"  ว าร ส าร ก าร ว ัด ผ ล ก าร ศ ึก ษ า . 17: 

(พ ฤ ษ ภ าค ม  -  ส ิงห าคม  2 5 3 8 ) 11 - 2 4 .

บ ุญ ช ม  ศร ีส ะอ าด . ร ูป แบ บ ซ องผลการเร ียน ใน โรงเร ียน ■ ว ิท ยาน ิพ น ธ ์ป ร ิญ ญ าด ุษ ฎ ีบ ัณ ฑ ิต  

ม ห าว ิท ยาล ัยศร ีน ค ร ิน ท รว ิโรฒ  ป ระส าน ม ิตร, 2 5 2 4 .

บ ูรช ัย ศ ึร ิม ห าส าค ร. ก ารส ร ้างแ ล ะ ก ารใช ้แ ฟ ้ม ส ะ ส ม ผ ล งาน  P ortfolio  P lu s  เก A c tio n .

ก ร ุง เท พ ม ห าน ค ร : อ ัก ษ รเจ ร ิญ ท ัศ น ์, 2 5 4 1 .

ป า จ ร ีย ์ ว ัช ว ัลลค ุ. ค ว าม ล ้ม พ ัน ธ ์ร ะ ห ว ่างอ งค ์ป ร ะ ก อ บ ท างด ้าน ล ัก ษ ณ ะ ข อ งน ัก เร ีย น  ส ภ าพ  

แ ว ด ล ้อ ม ท างบ ้าน  ส ภ าพ แ ว ด ล ้อ ม ท างโรง เร ีย น ท ี่ม ืผ ล ต ่อ ผ ล ล ้ม ฤ ท ธ ิ้ท างก าร เร ียน  

ค ณ ิต ศ า ส ต ร ์ ระด ับ ป ระถ ม ศ ึก ษ าใน ก ร ุง เท พ ม ห าน ค ร. ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ าม ห าบ ัณ ฑ ิต  

จ ุฬ าล ง ก ร ณ ์ม ห าว ิท ย าล ัย , 2 5 2 6 .

ภ ัท ร าพ ร ร ณ  ส ุขประชา. ผ ล ข อ งก ารป ระเม ิน ผล งๆ น ข อ งน ัก เร ียน โด ยต น เอ งแล ะโด ยค ร ู ท ี่ม ืต ่อแรง 

จ ูง ใจ ใฝ ล ้ม ฤ ท ธ ิ้ ก ารร ับ ร ู้ค ว าม ส าม ารถ ข อ งต น เอ ง แ ล ะ ผ ล ล ้ม ฤ ท ธ ื้ใน ว ิช าค ณ ิต ศ าส ต ร ์ 

ข อ งน ัก เร ียน ม ัธ ยม ศ ึก ษ าป ีท ี่ 2 . ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ าม ห าบ ัณ ฑ ิต  จ ุฬ า ล ง ก ร ณ ์

ม ห า ว ิท ย า ล ัย ,  2 5 4 1 .
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ย ุพ า  เว ีย งก ม ล . ผ ล ข อ งก ารป ?ะ เม ิน ต น เอ งโด ยใช ้แ ฟ ้ม ส ะส ม ผ ล งาน ท ี่ม ีต ่อ ค วาม เช ื่อ ม ัน ใน ต น เอ ง 

ช อ งน ัก เร ียน ช ัน ป ระถ ม ศ ึก ษ าป ีท ี่ 6 ท ี่ม ีผ ล ล ัม ฤ ท ธ ึ๋ท างก าร เร ีย น ต ํ่า . ว ิท ย าน ิพ น ธ ์ 

ป ร ิญ ญ า ม ห า บ ัณ ฑ ิต  จ ุฬ า ล ง ก ร ณ ์ม ห าว ิท ย าล ัย , 2 5 4 1 .

ย ุพ ิน  พ ิพ ิธก ุล . ก าร เร ิย น ก าร ส อ น ค ณ ิต ศ าส ต ร ์. ก ร ุง เท พ ม ห าน คร : บ พ ิธ ก าร พ ิม พ ์จ ำก ัด  2 5 3 4 .

ว ิช าก าร , กรม. ก ารจ ัด ท ำแ ฟ ้ม ส ะ ส ม ป ระ ส บ ก ารณ ์แ ล ะ ก าร เร ีย น ร ู้ (P o rtfo lio ). กร ุงเทพฯ : 

บ ูร พ าส าส ์น (1 9 9 1 ), 2 5 4 0 .
ว ิช ุด า  ก ู้พ ง ษ ์ส ว ล ัด ิ้.  ส ถ าน ภ าพ ข อ งก ารใช ้ค อ ม พ ิว เต อ ร ์ใน ป ระ เท ศ ไท ย.วารส าร.ส ลท  

ฉ บ ับ เท คโน โลย ี 14 (พ ฤ ษ ภ าค ม  2 5 3 0 )

ว ิโรจน ์ รอดเด ็น . ก า?น ำเส น อ ร ูป แ บ บ แ ฟ ้ม ส ะ ส ม ผ ล งาน ผ ล งาน อ ิเล ็ก ท รอ น ิก ส ั ส ำห ร ับ น ัก เร ียน  

ป ร ะ ถ ม ศ ึก ษ า  ล ังก ัด ส ำน ัก งาน ค ณ ะ ก ร ร ม ก าร ก าร ศ ึก ษ าเอ ก ซ น . ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ า  

ม ห าบ ัณ ฑ ิต  จ ุฬ า ล ง ก ร ณ ์ม ห า ว ิท ย า ล ัย , 2 5 4 2 .

วรรณ ด ี ช ุณ ห 1ว ุฒ ิย าน น ท ์. เอ ก ส ารป ระ ก อ บ ค ำบ รรยาย เรอ ง Portfolio การส อน ของคร ู

(T e a c h in g  P o rtfo lio ). งาน ว ัด ผ ล ป ระ เม ิน ผ ล  ฝ ่ายน ิเท ศ งาน ส น ับ ส น ุน ก ารส อ น  หน ่วย 

ศ ึก ษ า น ิเท ศ ก ์ ก ร ม ส าม ัญ ศ ึก ษ า .

ค ิร ิช ัย  ก าญ จ น ว าส ี. เอ ก ส ารป ระ ก อ บ ก าร เร ียน ท ฤ ษ ฏ ีก ารว ัด แ ล ะ ป ระ เม ิน . ก ร ุง เท พ ม ห าน คร,

2 5 3 4 .

ส ิร ิพรรณ  พรรณ โกส ุม . ผ ลข อ งก ารป ระ เม ิน ต น เอ งท ี่ม ีต ่อ ุค วาม ส น ใจ ใน ก ิจก รรม แ ล ะ ผ ล ล ัม ฤ ท ธ ิ้ใน  

ว ิช าค ณ ิต ศ าส ต ร ์ข อ ง น ัก เร ีย น ช ั้น ม ัธ ย ม ศ ึก ษ าป ีท ี่ 2 . ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ าม ห าบ ัณ ฑ ิต  

จ ุฬ า ล ง ก ร ณ ์ม ห า ว ิท ย า ล ัย , 2 5 3 7 .

ส ุภ า ณ ี ป ิย ะ อ ภ ิน ัน พ ์ ค ว าม ส ัม พ ัน ธ ์ร ะ ห ว ่างค ุณ ภ าพ ก า?ส อ น ข อ งค ร ู แ ล ะ บ รรยาก าศ ใน ห ้อ งเร ียน  

ต าม ก า?ร ับ ร ู้ข อ งน ัก เร ีย น  ก ับ แ ร งจ ูงใจ ใฝ ่ล ัม ฤ ท ธ ิ้ต ่อ ว ิช าค ณ ิต ศ าส ต ร ์ ของน ัก เร ียน ระด ับ  

ช ั้น ม ัธ ย ม ศ ึก ษ า . ว ิท ย าน ิพ น ธ ์ป ร ิญ ญ าม ห าบ ัณ ฑ ิต  จ ุฬ าล ง ก ร ณ ์ม ห าว ิท ย าล ัย , 2 5 3 9 .

ส ุร างค ์ โค ้วตระก ูล . จ ิต ว ิท ย า ก า ร ศ ึก ษ า . กร ุง เท พ ม ห าน ค ร : ส ำน ัก พ ิม พ ์จ ุฬ าล ง ก ร ณ ์ม ห าว ิท ย าล ัย , 

2 5 3 3 .

ส. วาส น า ป ร ะ ว าล พ ฤ ก ษ ์. แ น ว ค ิด ก ารป ร ะ เม ิน จ าก ส ภ าพ จ ร ิง . เอกส ารป ระกอบ การผ ึเกอบ รมเซ ิง 

ป ฏ ิบ ัต ิก าร . กระบี่ : ส ำน ัก งาน โค รงก ารพ ัฒ น าท ร ัพ ยาก รม น ุษ ย ์, 2 5 3 9 .
อ รพ ัน ธ ์ ประส ิทธ ิร ัตน ์. ค อ ม พ ิว เต อ ร ์เพ ื่อ ก าร เร ีย น ก าร ส อ น ุ. กร ุง เท พ มห าน คร 

บ ร ิษ ัท ค ราฟ แ ม น เพ รส  1 2 5 30 .
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B arre tt, H .c .  H ow  to  c r e a t e  v o u r  ow n  e le c tro n ic  p o rtfo lio . [O n line], A v a ila b le  from  : 

h t tp :// tra n s itio n .a la sk a .e d u /w w w /p o rtfo l io s /h o w to /in d e x .h tm l, [2 0 0 0 , N .D.] 

B a rre tt, H .c .  C o lla b o ra t iv e  p la n n in g  for e le c tro n ic  p o rtfo lio s  : A sk in g  s t r a te g ic  

q u e s t io n s . [O n line ], A v a ila b le  from  :

h ttp :/ / tra n s it io n .a la s k a .e d u /w w w /p o rtfo l io s /p la n n in g .h tm l , [2 0 0 0 , N .D.]

B arre tt, H .c .  T e c h n o lo g y  -  S u p p o r te d  P ortfolio  A s s e s s m e n t . [O n line]. A v a ila b le  from  : 

h ttp :// tra n s itio n .a la sk a .e d u /w w w /p o rtfo l io s /e le c tro n ic P o r tfo l io .h tm l, [2 0 0 0 , N .D.] 

B a rre tt, H .c .  E le c tro n ic  T e a c h in g  P ortfo lios : M u ltim ed ia  Skills +  Portfolio  D e v e lo p m e n t 

P o w e rful P ro fe s s io n a l D e v e lo p m e n t. [O n line], A v a ilab le  from  : 

h ttp :// tra n s it io n .a la s k a .e d u /w w w /p o rtfo i io s /s ite 2 0 0 0 .h tm l , [2 0 0 0 , N .D.]

B lack , P .D ., R e is , H .T., a n d  J a c k s o n ,  L. T h e  e f fe c ts  of v e rb a l r e in fo rc e m e n t on  in trinsic  

m o tiv a tio n  for s e x - lin k e d  ta s k s .  S e x  R o le s  1 0 (1 9 8 4 ) : 3 6 9  -  38 7 .

B o g g ia n o , A .K ., B a rre tt, M., W eih er, A .W ., M cC le llan d , G .H ., a n d  L usk , C .M . U se  of th e  

m a x im a l-o p e ra n t p r in c ip le  to  m o tiv a te  c h i ld re n ’s  in trinsic  in te re s t. J o u rn a l of 

P e rso n a li ty  a n d  S o c ia l P s y c h o lo g y  5 3  (1 9 8 7 ) : 8 6 6 -8 7 9 .

C a ld e r , B .J ., a n d  S taw , B.M. In te ra c tio n  of in trinsic  a n d  e x trin s ic  m o tiv a tio n  : S a m e  

m e th o d o lo g ic a l  n o te s . Jo u rn a l of P e rso n a lity  a n d  S o c ia l P s y c h o lo g y  

31 (1 9 7 5 ) : 76  - 8 0 .

D eci. E.L., V a lle ra n d , J .R ., P e lle tie r, G .L ., a n d  R y an , M.R. M otivation  a n d  e d u c a t io n  : T h e  

s e lf -d e te rm in a tio n  p e r s p e c t iv e .  E d u c a tio n a l P s y c h o lo g is t  3 a n d  4  (1 9 9 1 ) :

3 2 5  -3 4 6 .

D eci. E.L., a n d  P o ra c , C .E .M . C o g n itiv e  e v a lu a tio n  th e o ry  a n d  th e  s tu d y  of h u m a n

m otiva tion . In M.R. L e p p e r  a n d  D .G re e n  (e d s .) ,  T h e  H id d e n  c o s t  of r e w a r d s , 

p p . 1 4 9 -1 7 6 . N .J. : L a w re n c e  E rlb a u m e  A s s o c ia te s ,  1978 .
D ec i. E.L., a n d  R y an , M.R. T h e  s u p p o r t  of a u to n o m y  a n d  th e  c o n tro l b e h a v io r . J o u rn a l of 

P e r s o n a lity a n d  S o c ia l P s y c h o lo g y  5 3 (1 9 8 7 )  : 1 0 2 4 -1 0 3 7 .

http://transition.alaska.edu/www/portfolios/howto/index.html
http://transition.alaska.edu/www/portfolios/planning.html
http://transition.alaska.edu/www/portfolios/electronicPortfolio.html
http://transition.alaska.edu/www/portfoiios/site2000.html
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D eci. E.L., S c h w a rtz , A .J ., S c h e in m a n , L , a n d  R y an , R.M. A n in s tru m e n t to  a s s e s s

a d u l ts  o r ie n ta tio n  to w a rd  c o n tro l v e r s u s  a u to n o m y  w ith c h ild re n  : R e f le c tio n s  on 

in trin sic  m o tiv a tio n  a n d  p e r c e iv e d  c o m p e te n c e .  Jo u rn a l of E d u c a tio n  

P s y c h o lo g y  7 3  (1 9 8 1 ) : 6 4 2 -6 5 0 .

D eci. E.L., V a lle ra n d , J .R ., P e lle tie r , G .L ., a n d  R y an  M.R. M otivation a n d  e d u c a t io n  : T he  

s e lf  -  d e te rm in a tio n  p e r s p e c t iv e .  E d u c a tio n a l P sy c h o lo g is t  3 a n d  4  (1991 ) :

3 2 5  -  3 4 6 .

E nzle , M .E. a n d  R o ss , J . M. เท c r e a s in g  a n d  d e c r e a s in g  in trinsic  in te re s t  w ith c o n tin g e n t  

r e w a r d s  : A  t e s t  o f c o g n itiv e  e v a lu a t io n  th e o ry . Jo u rn a l of E x p e rim e n ta l S o c ia l 

P s y c h o lo g y . 1 4 (1 9 7 6 )  : 5 8 8 - 5 9 7 .

F ish e r, c. F. T h e  e f fe c ts  o f p e r s o n a l  c o n tro l, c o m p e te n c e  a n d  e x trin s ic  re w a rd  s y s te m s  

o n  in tr in sic  m o tiv a tio n . O rg a n iz a t io n a l B e h a v io r  a n d  H u m an  P e r f o r m a n c e . 21 

(1 9 7 8 ) : 2 7 3 - 2 8 8 .

G o ttfr ied , A .E . A c a d e m ic  in tr in sic  m o tiv a tio n  in e le m e n ta ry  a n d  ju n io r h ig h  s c h o o l 

s tu d e n t .  J o u rn a l  o f E d u c a tio n a l P s y c h o lo g y . 2 0 (1 9 8 5 ) : 2 0 5 -2 1 5 .

L e p p e r , M .R ., a n d  H a d e ll , M. In s tr in s ic  M otivation  in th e  C la s s ro o m . เท c. A m e s  a n d  R. 

A m e s  ( e d s .) ,  R e s e a r c h  o n  m o tiv a tio n  in th e  e d u c a t io n  : G o a ls  a n d  c o g n i t io n s , 

p p . 7 3 -1 0 1 . N ew  Y ork : A c a d e m ic  p r e s s ,  1989 .

R o se n h o ltz , S .J .,  a n d  S im p s o n , c. T h e  fo rm a tio n  o f ab ility  c o n c e p t io n s  : D e v e lo p m e n ta l 

t r e n d  o r s o c ia l  c o n s tru c t io n . R ev iew  of E d u c a tio n  R e s e a r c h . 5 4 (1 5 8 4 a )  : 3 1 -6 5 .

R o se n h o ltz , S .J . ,  a n d  S im p s o n , c. C la s s ro o m  o rg a n iz a t io n  a n d  s tu d e n t  s tra tif ic a tio n . T he  

e le m e n ta r y  S c h o o l J o u r n a l . 8 5 (1 9 8 4 b )  : 2 1 -3 7 .

Z u c k e rm a n , M., P o r a c e ,  J . ,  L ath in , D., S m ith , R. a n d  D ec i, E.L. O n  th e  im p o r ta n c e  of 

s e lf  - d e te rm in a tio n  fo r in tr in s ica lly  m o tiv a te d  b e h a v io r . P e rso n a lity  a n d  S o c ia l 

P s y c h o lo g y  B u lle tin e  4  (1 9 7 8 ) : 4 4 3 -4 4 6 .



ภาคผนวก



ภาคผนวก ก
รายนามผู้ทรงคุณวุฒิ



รายนามผู้ทรงคุณวุฒ ิตรวจสอบรูปแบบแฟ้มสะสมผลงานอิเล็กทรอนิกส์

1. อ า จ า ร ย ์ ดร.ร ังสรรค ์ ม ณ ีเล ็ก

น ัก ว ิช า ก า ร ศ ึก ษ า  7 ส ำน ัก งาน ค ณ ะ ก รรม ก ารป ระ ถ ม ศ ึก ษ าแ ห ่งช าต ิ

2. อ า จ า ร ย ์ ดร.ชวล ิต  โพธนคร

น ัก ว ิช า ก า ร ศ ึก ษ า  7 ส ำน ัก งาน ค ณ ะ ก รรม ก ารป ระ ถ ม ศ ึก ษ าแ ห ่งช าต ิ

3. อ าจ าร ย ์จ ร ัล  ค ำย ัง

น ัก ว ิช าก ารล อ บ  7ว ส ำน ัก งาน ท ด ส อ บ ท างก ารศ ึก ษ า ก รม ว ิช าการ

4. อ า จ า ร ย ์ม ัล ล ิก า  ย ุว น ะ เต ม ีย ์

ศ ึก ษ าน ิเท ศ ก ํร ะ ด ับ  6  ส ำน ัก งาน ค ณ ะ ก รรม ก ารก ารศ ึก ษ าเอ ก ซ น

5. ร อ ง ศ า ส ต ร า จ าร ย ์ ดร.ส ำล ี ทองธิว

ภ า ค ว ิช าป ร ะ ถ ม ศ ึก ษ า  ค ณ ะ ค ร ุศ าส ต ร ์ จ ุฬ าล ง ก ร ณ ์ม ห าว ิท ย าล ัย

รายนามผู้ทรงคุณวุฒิตรวจสอบโปรแกรมสร้างแฟ้มสะสมผลงานอิเล็กทรอนิกส์

1. อ า จ า ร ย ์ ดร.ร ังสรรค ์ ม ณ ีเล ็ก

น ัก ว ิช าก าร ศ ึก ษ า  7 ส ำน ัก งาน ค ณ ะ ก รรม ก ารป ระ ถ ม ศ ึก ษ าแ ห ่งช าต ิ

2. อ า จ า ร ย ์ ดร.ชวล ิต  โพธนคร

น ัก ว ิช าก าร ศ ึก ษ า  7 ส ำน ัก งาน ค ณ ะ ก รรม ก ารป ระ ถ ม ศ ึก ษ าแ ห ่งช าต ิ

3. อ า จ า ร ย ์ ด ร .ก ำพ ล  ด ำร งว งค ์

ศ ึก ษ าน ิเท ศ ก ์ร ะ ด ับ  6  ส ำน ัก งาน ค ณ ะ ก รรม ก ารก ารศ ึก ษ าเอ ก ซ น

4. อ า จ า ร ย ์ ดร.อน ุช ัย  ธ ีระเร ืองไชยศร ี

ภ าค ว ิช าบ ร ิห าร เภ ส ัช ก ิจ  ค ณ ะ เภ ส ัช ศ าส ต ร ์ จ ุฬ าล ง ก ร ณ ์ม ห าว ิท ย าล ัย

5. อ า จ า ร ย ์ช ย ก า ร  ค ีร ีร ัตน ์

ห ัว ห น ้าห ม ว ด ว ิช าค อ ม พ ิว เต อ ร ์ โ ร ง เร ีย น ส าธ ิต จ ุฬ าล งก ร ณ ์ม ห าว ิท ย าล ัย  ฝ ่าย ม ัธ ย ม
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รายนามผู้ทรงค ุณ ว ุฒ ติรวจสอบแผนการสอน เนอหา ใบงาน ต้วอย่างผลงาน เกณฑ์ 
การประเมินผล แ ล ะ แบบทดสอบ

1. ผ ู้ช ่ว ย ศ า ล ต ร า จ า ร ย ์ด ร .ส ุก ร  รอดโพ'ธิ้ทอง

ภ าค ว ิช าโ ส ต ท ัศ น ศ ึก ษ า  ค ณ ะ ค ร ุศ าส ต ร ์ จ ุฬ าล ง ก ร ณ ์ม ห าว ิท ย าล ัย

2. อ า จ า ร ย ์ ด ร .ก ำพ ล  ด ำร งว งค ์

ศ ึก ษ าน ิเท ศ ก ์ร ะ ด ับ  6  ส ำน ัก งาน ค ณ ะ ก ร ร ม ก าร ก ารศ ึก ษ าเอ ก ช น

3. อ าจ าร ย ์ส ม ป ร ะ ส ง ค ์ ส ิงค ช าต ิ

ห ัว ห น ้าฝ ่าย น โ ย บ าย แ ล ะ แ ผ น  โรงเร ียน ส าม เส น ว ิท ยาล ัย

4. อ า จ า ร ย ์ช ย ก า ร  ค ีร ีร ัตน ์

ห ัว ห น ้าห ม ว ด ว ิช าค อ ม พ ิว เต อ ร ์ โ ร ง เร ีย น ส าธ ิต จ ุฬ าล งก ร ณ ์ม ห าว ิท ย าล ัย  ฝ ่าย ม ัธ ย ม

5. อ า จ าร ย ์อ ม ร ิน ท ร ์ อ ำ พ ล พ ง ษ ์

ห ัว ห น ้าศ ูน ย ์ค อ ม พ ิว เต อ ร ์ โ ร ง เร ีย น ส าธ ิต จ ุฬ าล งก ร ณ ์ม ห าว ิท ย าล ัย  ฝ ่าย ม ัธ ย ม

รายนามผู้ทรงคุณวุฒ ิตรวจสอบแบบวัดความสนใจในกิจกรรม

1. ผ ู้ช ่ว ย ศ าส ต ร าจ าร ย ์น ิร ัน ด ร ์ แสงสว ัสด ิ้

ภ า ค ว ิช า ล า ร ัต ถ ศ ึก ษ า  ค ณ ะ ค ร ุศ าส ต ร ์ จ ุฬ า ล ง ก ร ณ ์ม ห า ว ิท ย า ล ัย

2. ผ ู้ช ่ว ย ศ าล ต ร าจ าร ย ์พ ิไ ล  แ ย ้ม งาม เห ล ือ

อ ด ีต อ าจ าร ย ์ป ร ะ จ ำห ม ว ด ว ิช าแ น ะ แ น ว  โ ร ง เร ีย น ส าธ ิต จ ุฬ าล งก ร ณ ์ม ห าว ิท ย าล ัย  ฝ ่าย ม ัธ ย ม

3. ร อ ง ศ า ส ต ร า จ าร ย ์ ดร.ล ุช ีรา ภ ัท ร าย ุต ว ร รต น ์ 

ค ณ ะ แ พ ท ย ศ า ส ต ร ์ ค ิร ิร าช พ ย าบ าล
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ภาคผนวก ข
ตัวอย่างหนังสิอขอความร่วมมึอ่ในการวิจัย



ท่ี ทม.0302(2770.0603)13b9 ฝ่ายวิชาการ คณะครุศาสตร  ์
จุฬาลงกรณ์มหาวิทยาลัย 
ถนนพญาไท กรุงเทพฯ 10330

2 0  ก ร ก ฎ า ค ม  2 5 4 4

เร่ึอง ขอเชิญเป็นผู้ทรงคุณ'วุฒิตราจสอบเครี่องมือ'วิจัย

เรียน อาจารย์ประสงค์ ลงคชาติ

สั๋งที่ส่งมาด้วย เครื่องมือที่,ใช้ในการวิจัย

ด้วย นายประกอบ กรณีกิจ นิสิตขั้นปริญญามหาบัณทัต ภาควิชาโสตทัศนสืกษา สาซาวิชาโสตทัศน 
จึกษา อยู่ในระหว่างการดำเนินงานวิจัยวิทยานิพนธ์เรื่อง “ผลของความมีอิสระขอ่งการสร้างผลงานในแฟ้มสะสม 
งานอิเล็กทรอนิกส์ที่ม ีต่อความสนใจในกิจกรรมและผลลัมฤทธิ๋ทางการเรียนในวิชาโปรแกรมประยุกต์ของนักเรียน 
ชั้นมัธยมสืกษาปีที่ 1” โดยมี อาจารย ์ดร.บ ุญ เร ีอง เนิยมหอม เป็นอาจารย์ท ี่ปรึกษา ในการนี้จ ึงขอเช่ญท่าน  
เป็นผู้ทรงคุณวุฒิตรวจลอบเครื่องมีอวิจัยที่นิสิตสร้างขึ้น

จึงเรียนมาเพ ี่อขอความอนุเคราะห์จากท่านโปรดเป็นผู้ทรงคุณวุฒ ิด ังกล่าว เพี่อประโยชน์ทางวิชาการ 
ต่อไป และขอขอบคุณมาในโอกาสนี้

ขอแสดงความนับถือ

(ผู้ช ่วยศาสตราจารย์ ดร.ส ุล ักษณ ์ ศรีบุรี) 
รองคณบด้ฝ่ายวิชาการ 

ปฎบัติราชการแทนคณบดีคณะครุศาสตร์

ฝ ่ายวิชาการ
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ภ า ค ผ น ว ก  ค  

ค ะ แ น น ค ว า ม ส น ใ จ
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ตารางที่ 6 แสดงคะแนนความสนใจของกลุ่มทดลองที่ 1 : ท่ีได้รับโอกาสในการเลือกสร้างผลงาน 
ในแฟ้มละลมผลงานอิเล็กทรอนิกส์' และกลุ่มทดลองท่ี 2 : ท่ีไม่ได้รับโอกาสในการเลือกสร้าง 
ผลงานในแฟ้มสะสมผลงานอิเล็กทรอนิกส์ จำนวนกลุ่มละ 20 คน

คนท่ี ความสนใจ
กลุ่มทดลองท่ี 1 กลุ่มทดลองท่ี 2

1 82 74
2 81 97
3 80 108
4 87 87
5 85 87
6 96 78
7 82 78
8 86 69
9 88 83
10 70 89
11 91 96
12 84 69
13 96 71
14 78 59
15 93 72
16 99 80
17 90 96
18 89 85
19 80 71
20 71 71
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ภ าค ผ น ว ก  ง
ค ะ แ น น ผ ล ส ้ม ฤ ท ธ ท าง ก าร เร ีย น ข อ ง ก ล ุ่ม ต ัว อ ย ่าง
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ตารางที่ 7 แสดงผลสัมฤทธทางการเรียนของกลุ่มทดลองที่ 1 : ท่ีได้รับโอกาสในการเลือกสร้าง 
ผลงานในแฟ้มสะสมผลงานอิเล็กทรอนิกส์’ และกลุ่มทดลองท่ี 2 : ท่ีไม'ได้รับโอกาสในการเลือก 
สร้างผลงานในแฟ้มสะสมผลงานอิเล็กทรอนิกส์’ จำนวนกลุ่มละ 20 คน

คนท่ี ผลสัมฤทธี้ทางการเรียน
กลุ่มทดลองท่ี 1 กลุ่มทดลองท่ี 2

1 19.75 .00
2 8.50 4.50
3 10.50 24.92
4 22.08 30.17
5 7.17 19.67
6 29.67 21.83
7 2.50 25.17
8 23.33 19.50
9 25.67 6.83
10 24.33 17.75
11 9.42 24.92
12 20.33 16.17
13 13.25 15.00
14 26.67 13.00
15 10.33 24.00
15 25.00 26.33
17 29.67 4.33
13 13.75 18.33
19 21.00 20.50
29 20.42 16.58



ภาคผนวก จ
(ว ัว 'อย ่างแบ บ ท ด ส 'อบ ว ัด ผ ลส ้ม ฤ ท ธท างก ารเร ึยน
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แบบทดสอบก่อนเรืยน วิชา Microsoft Word97
คำชี้แจง : ข้อสอบมีท้ังหมด 25 ข้อ
จงทำเครื่องหมาย X ลงในกระดาษคำตอบ

1. ถ้านักเรียนต้องการพิมพ์ตัวเลข 23 อยากทราบว่าในส่วนของเลข 3 นักเรียนต้องเลือกคำลังใน 
การกำหนดลักษณะตัวอักษรอย่างไร

ก. Subscript 
ข. Superscript 
ค. Strikethrough 
ง. Double Strikethrough

2. ถ้าต้องการกำหนดสีตัวอักษร นักเรียนต้องใช้เคร่ืองมือใด

ก. ค.

3. ถ้าต้องการจัดรูปแบบย่อหน้าชิดขอบทั้ง 2 ข้าง นักเรียนต้องใช้เคร่ืองมือใด

ก. ค.

4. ถ้าต้องการกำหนดก้ันหน้าของบรรทัดแรกในย่อหน้านั้น นักเรียนต้องใช้เครื่องมือใด
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ใช้ภาพด้านล่างนี้ต อ บ คำถามข้อ 5

ลม 123.45 ลานตัน
ล้ินจ่ี 325.456 ลานตัน
เงาะ 326.654 ลานตัน
ลำไอ 9876.3569 ลานตัน

5. จากภาพทีก่ ำห น ด ให้ ในล่'วน1ของตัวเลข อยากทราบว่าต้องทำการกำหนด Tab แบบใด จึงจะ 
ได้เอกสารดังภาพ

ก. ค.

6. Pli การคลิกที่เครื่องมือดังกล่าวหมายถึงคำสั่ง'ใด 
ก. เรียกแถบเครื่องมือ Picture Toolbar 
ข. เรียกแถบเครืองมือ Drawing Toolbar 
ค. เรียกแถบเครืองมือ Formatting Toolbar 
ง. เรียกแถบเครื่องมือ Word Art Toolbar

ใช ้ภาพด้านล่างนีต้ อ บ คำถามข้อ 7

♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦

7. ถ้าต้องการก ำห น ด ลวดลายภายในให้กับรปลีเหลียมดังภาพ อยากทราบว่าต้องใช้เครืองมือในข้อ
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8. ข้อใดคือวิธีการกำหนดรูปแบบสัญลักษณ์แสดงหัวข้อย่อย หลังจากเข้าฟู ไดอะล็อกบ็อกซ์ 
สัญลักษณ์แสดงหัวข้อย่อยและลำดับเลข (Bullets and Numbering)

ก. คลิกป ม กำหนดเอง (Customize) > เลือกสัญลักษณ์ที่ต้องการ 
ข. คลิกป ม ต้ังค่า (Setting) > เลือกสัญลักษณ์ที่ต้องการ
ค. คลิกป ม ตั้งค่า (Setting) > คลิกปมแบบอักษร (Font) > เลือกสัญลักษณ์ที่ต้องการ 
ง. คลิกป ม กำหนดเอง (Customize) > คลิกปมสัญลักษณ์แสดงหัวข้อย่อย (Bullet) > 

เลือกสัญลักษณ์ที่ต้องการ

9. ข้อใดคือวิธีการยกเลิกการกำหนดสัญลักษณ์แสดงหัวข้อย่อย (Bullet) ที่ถูกต้อง
ก. คลิกเมาสัที่เครื่องมือกำหนดสัญลักษณ์แสดงหัวข้อย่อย 
ข. เลื่อนตัวบอกตำแหน่งการพิมพ์ (Cursor) ไปยังบรรทัดที่ต้องการยกเลิก > คลิกเมาสัที่ 

เครื่องมือกำหนดสัญลักษณ์แสดงหัวข้อย่อย 
ค. คลิกเลือกเมนูคำสั่ง Edit > Delete 
ง. คลิกเลือกเมนูคำลัง Tools > Delete Bullet

10. ข้อใดคือวิธีการวาดรูปจากรูปร่างอัตโนม่ติ ในขณะลากเมาสัเพื่อวาดรูป ท่ีถูกต้อง
ก. กดแป้น Shift ค้างไว้ จะได้รูปทรงท่ีมืสัดลํวนไม่คงท่ี 
ข. กดแป้น Shift ค้างไว้ จะได้รูปทรงท่ีมืสีสันสวยงาม 
ค. กดแป้น Ctrl ค้างไว้ จะได้รูปทรงท่ีมืสัดส่วนคงท่ี
ง. กดแป้น Ctrl ค้างไว้ จะได้รูปทรงที่มืจุดศูนย์กลางของภาพอยู่ที่ตำแหน่งเรื่มวาด 11

11. ถ้านักเรียนต้องการแทรกรูปภาพจาก Microsoft Clip Gallery นักเรียนต้องใช้คำสั่งอย่างไร
ก. เลือกคำลัง Insert > Object > Clip Art 
ข. เลือกคำลัง Insert > Object > From File 
ค. เลือกคำลัง Insert > Picture > Clip Art 
ง. เลือกคำลัง Insert > Picture > From File
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12. ถ้านักเรียนต้องการแทรกรูปภาพจากแฟ้มข้อมูลรูปภาพที่ได้จากการสแกนด้วย Scanner นักเรียน 
ต้องใช้คำลังอย่างไร

ก. เลือกคำสัง Insert > Object > Clip Art 
ข. เลือกคำสัง Insert > Object > From File 
ค. เลือกคำลัง Insert > Picture > Clip Art 
ง. เลือกคำลัง Insert > Picture > From File

ใช้ภาพด้านล่างตอบคำถามข้อ 13 13 14 * * *

13. จากภาพเครื่องมือที่ใช้ในการกำหนดการตัดข้อความ (Text wrapping) คือเครื่องมือหมายเลขใด

ก. หมายเลข1 ข. หมายเลข2 ค. หมายเลข3 ง. หมายเลข4

14. ถ้านักเรียนต้องการแทรกข้อความคืลป็ (WordArt) นักเรียนต้องใช้คำลังอย่างไร
ก. Insert > WordArt
ข. Insert > Picture > WordArt 
ค. View > Tool > WordArt
ง. View > Object > WordArt
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15. จากภาพด้านล่าง ถ้าต้องการเข้าล่คลังข้อความคืลป๋ (WordArt Gallery) เพ่ือเปลี่ยนรูปแบบ 
WordArt ให้เป็นรูปแบบใหม่ ต้องใช้เครื่องมือหมายเลขใด

ก. หมายเลข1 ข. หมายเลข2 ค. หมายเลข3 ง. หมายเลข4

16. ในการจัดคอลัมน์ นักเรียนสามารถกำหนดได้จากแถบเครื่องมือมาตรฐาน (Standard Toolbar) 
อยากทราบว่าเครื่องมือที่ใข้กำหนดคอลัมน์ คือเคร่ืองมือในข้อใด

17. ถ้าต้องการกำหนดให้คอลัมน์มืฃนาดเท่ากัน นักเรียนจะต้องเลือกคำลังใด
ก. Mark Column Width (กำหนดความกว้างคอลัมน์)
ข. Fix Column Width (แก้ไขความกว้างคอลัมน์)
ค. Equal Column Width (ความกว้างของสดมภ์เท่ากัน)
ง. Select Column Width (เลือกความกว้างคอลัมน์) 18 * * *

18. ถ้านักเรียนต้องการปรับความกว้างของคอลัมน์ นักเรียนจะใช้คำลังอย่างไร
ก. เลือกคำลัง Tools > Columns
ข. เลือกคำลัง Tools > Columns > Width and Spacing 
ค. เลือกคำลัง View > Columns > Width and Spacing
ง. Drag Mouse ปรับเคร่ืองหมายขอบเขตคอลัมน์บนไม้บรรทัด
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19. ถ้านักเรียนต้องการจัดคอลัมน์หลายแบบ ในเอกสารเดียวกัน นักเรียนต้องเลือกตัวเลือกใดใน 
ส่วนของ Apply to (นำไปใช้กับ)

ก. Whole Document (ตลอดทังเอกสาร)
ข. Selected Text (ข้อความที่เลือก)
ค. Format Text (รูปแบบข้อความ)
ง. This Document (เอกสารนี)

20. ในกรณีที่นักเรียนจัดคอลัมน์2 คอลัมน์ และปรากฏว่าปลายข้อความในคอลัมน์ทั้งสองยาว 
ไม่เท่ากัน นักเรียนมีวิธีการปรับอย่างไรให้ปลายข้อความในคอลัมน์ทั้งลองนี้ยาวเท่ากัน 

ก. เลือกคำลัง Format > Columns
ข. เลือกคำลัง Format > Columns > Equal Width and Spacing
ค. เลือกคำลัง Insert > Break
ง. เลือกคำลัง Insert > Break > Continuous

21. ในการแทรกตารางนักเรียนสามารถใช้เครื่องมือบนแถบเครื่องมือมาตรฐาน (Standard Toolbar) 
ได้ อยากทราบว่าต้องใช้เครื่องมือในข้อใด

ก. ข. 53 ค.

22. จากภาพอยากทราบว่า ตารางที่ได้จะมืฃนาดเท่าใด

ก. 3 แถว X 4 คอลัมน์ 
ข. 4 แถว X 5 คอลัมน์ 
ค. 4 แถว X 3 คอลัมน์
ง. 5 แถว X 4 คอลัมน์
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24. ถ้าต้องการแทรกแถวในตาราง นักเรียนต้องใช้คำสิงอย่างไร
ก. เลือกคำสิง Insert > Rows 
ข. เลือกคำสัง Format > Insert Rows 
ค. เลือกคำสิง Table > Insert Rows 
ง. เลือกคำสิง Tools > Insert Rows

25. ถ้าต้องการจัดรูปแบบตารางจากภาพที่ 1 ให้เป็นดังภาพที่ 2 นักเรียนต้องใช้คำสิงในข้อใด

*=1 1 ciภาพท 1 ภาพท 2

ก. Split Cells ข. Merge Cells ค. Insert Cells ง. Select Cells

เฉลย
1. ข 2. ข 3. ง 4. ค 5. ข 6. ข 7. ค 8. ง 9. ข 10. ง 11. ค 12. ง
13. ง 14. ข 15. ค 16. ค 17. ค 18. ง 19. ข 20. ง 21. ค 22. ค 23. ค 24. ค
25. ข



ภาคผนวก ฉ
ค ่าความยากง่าย อำนาจจำแนก ความเที่ยงของแบบทดสอบ 

และสถิติที่ใชในการคำนวณ
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ตารางที่ 8 แสดงค่าความยากง่าย (p) อำนาจจำแนก (โ) และค่าความเที่ยง (KR20) ของแบบ 
ทดสอบวัดผลส์มฤทธิ้ทางการเรียน จำนวน 25 ข้อ

ข้อท่ี ค ่าความยากง่าย(p) ค่าอำนาจจำแนก (โ)
1 0.26 0.29
2 0.74 0.41
3 0.53 0.24
4 0.56 0.29
5 0.32 0.29
6 0.47 0.47
7 0.47 0.47
8 0.41 0.59
9 0.44 0.29
10 0.24 0.24
11 0.71 0.35
12 0.59 0.47
13 0.24 0.24
14 0.35 0.35
15 0.35 0.35
16 0.76 0.35
17 0.59 0.24
18 0.24 0.35
19 0.41 0.35
20 0.24 0.35
21 0.56 0.41
22 0.50 0.53
23 0.38 0.41
24 0.38 0.41
25 0.41 0.24

KR 20 = 0.89



สถิติที่ใช้ในการค ำ น ว ณ

1. หาระดับความยากง่าย (Difficulty)

R u +  R l ไชสูตร P = -----------
2f

P คือ ค่าระดับความยาก
Ru คือ จำนวนคนในกลุ่มลูงที่ตอบข้อลอบถูก
Rl คือ จำนวนคนในกลุ่มตํ่าท่ีตอบข้อสอบถูก
f คือ จำนวนคนในแต่ละกลุ่ม ซึ่งต้องมีจำนวนเท่ากัน

2. หาค่าอำนาจจำแนกรายข้อ (Discrimination)

ใช้สูตร D = — — —

D คือ ค่าอำนาจจำแนก
Ru คือ จำนวนคนในกลุ่มสูงท่ีตอบข้อสอบถูก
Rl คือ จำนวนคนในกลุ่มตํ่าท่ีตอบข้อสอบถูก
f คือ จำนวนคนในแต่ละกลุ่ม ซึ่งต้องมีจำนวนเท่ากัน

3. หาส้มประสิทธิ้แห่งความเท่ียงของแบบทดสอบ (Reliability) แบบคูเดอเริชาร์ตสัน (Kuder 
Richardson 20 : KR 20)

ใช้สูตร rxx = — - —  1 
ท -  1

pq 
ร 2

rxx คือ ค่าสัมประสิทธิแห่งความเท่ียง 
ท คือ จำนวนข้อสอบในแบบทดสอบ 
P คอ สัดส่วนของคนทตอบฃอลอบไดถูกตอง 
q คือ สัดส่วนของคนท่ีตอบผิดในแต่ละข้อ (q = 1 - p)
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p q คอ

Z p q คอ
ร 2 คอ

ผลคูณของสัดส่วนของผู้ที่ตอบถูกและตอบผิด (ความแปรปรวนของคะแนน 
แต่ละข้อ)
ผลบวกของ pq ทุก  ๆ ข้อ
ความแปรปรวนของคะแนนของผู้ถูกทดสอบท้ังหมด

ร 2 -  n fx 2 ~  c fx > 2
ท ( ท - 1)



ภาคผนวก ช 

แบบว้ดความสนใจ
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แบบวัดความสนใจ

ต,อนุท่ี 1
ชื่อ..................................................... นามสกุล.............................
เพศ...................อาย ุ..........................ชั้น.............................เลขท่ี

ดอนท่ี 2
ในระยะเวลา 2 เดือนที่ผ่านมานักเรียนได้กระทำพฤติกรรมหรือมีความรู้สึกต่อการเรียน 

วิชาคอมพิวเตอร์อย่างไรบ้าง ขอให้นักเรียนตอบตามความเป็นจริง โดยแต่ละข้อมีความหมายดัง
น้ี

ก. ถ้านักเรียนใส่เครื่องถูก ( V ) ลงในซ่อง “เห็นด้วยอย่างยิ่ง” หมายถึง นักเรียนทำ 
พฤติกรรมนั้นหรือมีความรู้สึกพึงพอใจตามข้อความนั้นมากที่ลุด

ข. ถ้านักเรียนใส่เครื่องถูก (V) ลงในซ่อง “เห็นด้วย’' หมายถึง นักเรียนทำ 
พฤติกรรมนั้นหรือมีความรู้สึกพึงพอใจตามข้อความนั้น่มาก

ค. ถ้านักเรียนใส่เครื่องถูก ( V ) ลงในซ่อง “ไม่แน่ใจ’, หมายถึง นักเรียนทำ 
พฤติกรรมนั้นหรือมีความรู้สึกพึงพอใจตามข้อความนั้นบางครั้งบางคราว

ง. ถ้านักเรียนใส่เครื่องถูก ( V ) ลงในซ่อง “ไม่เห็นด้วย,1 หมายถึง นักเรียนทำ 
พฤติกรรมน้ันหรือมีความรู้สึกพึงพอใจตามข้อความนั้นน้อย

จ. ถ้านักเรียนใส่เครื่องถูก ( V ) ลงในซ่อง “ไม่เห็นด้วยอย่างยิ่ง" หมายถึง นักเรียน 
ทำพฤติกรรมนั้นหรือมีความรู้สึกพึงพอใจตามข้อความนั้นน้อยที่สุด
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ข้อความ

ระด้บความคิดเห็น

เห็นด้วย 

อย่างยิ่ง

เห็นด้วย ไม,แน่ใจ ไม่เห็น 

ด้วย

ไม่เห็น 

ด้วย 

อย่างยิ่ง

1. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
สืกษาวิธีลัดหรือวิธีที่ช่วย ให้สร้าง 
เอกสารด้วยโปรแกรม Microsoft 
Word ได้รวดเร็วยิ่งข้ึน เมื่อม ีเวลา 
ว่าง...................................................

2. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
ปรับปรุงผลงานตามคำแนะนำของ 
ดร แล^พืดนด้วฅดวๆIIเต็บใจข

3. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
รู้สึก1ว่าการเรียนคอมพิวเตอร์'น่า 
สนใจ

4. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
ปฏิบัติงานตามใบงานกิจกรรม 
คอมพิวเตอร์ได้ลักครู่ ฉันหยุดและ 
เปลี่ยนไปทำกิจกรรมอื่น....................

5. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
จะเก็บเอกสารที่ครูแจกให้ในขณะ 
เรียนคอมพิวเตอร์ เม่ือครูขอตรวจ 
ลอบ.......................................

6. ในระยะเวลา 2 เดือนที่ผ่านมา เม่ือ 
ฉันทำการบ้าน ฉันจะปฏิบัติงาน 
คอมพิวเตอร์ตามข้อกำหนดใน
ใบงานกิจกรรมคอมพิวเตอร์เท่านั้น

7. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
มักจะทบทวนบทเรียน และเมื่อมี 

โอกาส ฉันซักถามปัญหาในการ 
ปฏิบัติงาน สร้างเอกสารด้วย 
โปรแกรม Microsoft Word กับ 
เพื่อนา และคร.................................1 'บิ
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ข้อความ

ระดับความคิดเห็น
เห็นด้วย 
'อย่างย่ิง

เห็นด้วย ไม่แนใจ ไม,เห็น 
ด้วย

ไม่เห็น 
ด้วย 

อย่างย่ิง
8. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 

รู้สึกสนุกในการปฏิบ้ติงานตามใบ 
งานกิจกรรมคอมพิวเตอร์................

9. ในระยะเวลา 2 เดือนที่ผ่านมา เม่ือ 
ฉันมีเวลาว่าง ฉันให้คำแนะนำใน 
ผลงานของเพ่ือนด้วยโปรแกรมสร้าง 
แฟ้มสะสมผลงานอิเล็กทรอนิกส์’

10. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
ให้คำแนะนำในผลงานของเพื่อน 
ด้วยโปรแกรมสร้างแฟ้มสะสม 
ผลงานอิเล็กทรอนิกส์’ด้วยความ 
สมัครใจ

11. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
ปฏิเสธที่จะปรับปรุงผลงานตาม 
คำแนะนำของครและเพื่อน...........

12. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
หลีกเลี่ยงการตรวจสอบผลงานและ 
ให้คำแนะนำในผลงานของเพื่อน 
เมื่ออินเตอร์เน็ตใช้งานได้ช้า...........

13. ในระยะเวลา 2 เดือนที่ผ่านมา เม่ือ 
ฉันไม่สามารถปฏิปติงานตามใบงาน 
กิจกรรมคอมพิวเตอร์ได้ ฉันจะเลิก 
ทำ

14. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
รู้สึกว่าการเรียนคอมพิวเตอร์ไม่ 
น่าสนใจ
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ข ้อความ

ระดับความคิดเห็น
เห็นด้วย 
'อย่างย่ิง

เห็นด้วย ไม,แน่ใจ ไม,เห็น 
ด้วย

ไม่เห็น 
ด้วย 

อย่างย่ิง
15. ในระยะเวลา 2 เดือนที่ผ่านมา เม่ือ 

ฉันมีเวลาว่าง ฉันเลือกทำแบบ 
แกหัดวิชาอื่นๆ มากกว่าการปฎิบ้ติ 
งานในกิจกรรมคอมพิวเตอร์ และ 
การสร้างแฟ้มสะสมผลงาน 
อิเล็กทรอนิกส์ ................................

16. ในระยะเวลา 2 เดือนที่ผ่านมา 
ฉันจะปฏิบัติงานในกิจกรรม 
คอมพิวเตอร์ ทีครูมอบหมายจน 
เสร็จก่อน แล้วจึงหยดพัก................q

17. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
รู้สึกไม่มีความสุขในการเรียน 
คอมพิวเตอร.์...................................

18. ในระยะเวลา 2 เดือนที,ผ่านมา เม่ือ 
ฉันได้รับมอบหมายให้ปฏิบัติงาน 
คอมพิวเตอร์ตามใบงาน ในวิชา 
คอมพิวเตอร์ ฉันรบทำให้เสร็จ 
เรียบร้อยก่อนกำหนด

19. ในระยะเวลา 2 เดือนที่ผ่านมา เม่ือ 
มีเวลาว่าง ฉันไม,เคยทบทวนหรือ 
ศึกษาเอกสารที่ครูแจกให้ในการ 
เรียนวิชาคอมพิวเตอร์

20. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
หลีกเลี่ยงการปฏิบัติงานตามใบงาน 
กิจกรรมคอมพิวเตอร์.......................

21. ในระยะเวลา 2 เดือนที่ผ่านมา ฉัน 
ศึกษาและค้นหาวิธีลัดหรือวิธีที่ช่วย 
ให้สร้างเอกสารด้วยโปรแกรม 
Microsoft Word ได้รวดเร็วย่ิงข้ึน 
ด้วยตนเอง.......................................
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ข้อความ

ระดับความคิดเห็น
เห็นด้วย 
อย่างย่ิง

เห็นด้วย ไม่แนา,จ ไม,เห็น 
ด้วย

ไม่เห็น 
ด้วย 

อย่างย่ิง
22. ในระยะเวลา 2 เดือนที่ผ่านมา แม้ 

ว่างานคอมพิวเตอร์ตามใบงานที่ครู 
มอบหมายให้จะยาก แต่ฉันยังทำ
ต่อไป...............................................

23. ในระยะเวลา 2 เดือนที่ผ่านมา 
คอมพิวเตอร์ เมื่อมีเวลาว่าง 
ฉันไม่ชอบปฏิบติงานตามใบงาน 
กิจกรรม.......................................

24. ในระยะเวลา 2 เดือนที่ผ่านมา เม่ือ 
มีเวลาว่าง ฉันจะตรวจลอบผลงาน 
และให้คำแนะนำสำหรับปรับปรุง 
ในผลงานของเพือน



ภาคผนวก ซ 
ตัว,อย่างแผนการสอน
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แผนการสอนระยะยาว จำนวน 8 กาบ

ครั้งที่ เรื่อง
1 - ชี้แจงภาระงานในการจัดทำแฟ้มละลมผลงาน

- นำเสนอตัวอย่างแฟ้มสะสมผลงาน และแฟ้มผลงานดีเด่น
- สร้างเกณฑ์การประเมินผลงาน

2 - การเปลี่ยนรูปแบบตัวอักษร (Font)
- การเปลี่ยนขนาดตัวอักษร (Size)
- การเปลี่ยนลักษณะของตัวอักษร (Style)
- การเปลี่ยนสีตัวอักษร (Color)
- การจัดรูปแบบย่อหน้า (Alignment)
- การตั้งกั้นหน้า ก้ันหลัง และการกำหนด Tab

3 - การแทรกสัญลักษณ์แสดงหัวข้อย่อย และลำดับเลข
- การยกเลิกการแทรกสัญลักษณ์แสดงหัวข้อย่อย และลำตับเลข
- การแทรกรูปวาด
- การกำหนดสีให้กับรูปวาด

4 - การแทรกรูปภาพ (Clip Art 1 From File)
- การจัดและตกแต่งรูปภาพ
- การแทรกข้อความ?เลป็ (WordArt)
- การปรับแต่งข้อความ?เลป็

5 - การจัดคอลัมน์ทั้งเอกสาร
- การจัดคอลัมน์หลายแบบในเอกสารเดียวกัน
- การจัดคอลัมน์ที่มีฃนาดเท่ากัน
- การจัดคอลัมน์ที่มีฃนาดไม่เท่ากัน
- การปรับความกว้างของคอลัมน์
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ครั้งที่ เรื่อง
6 - การแทรกตาราง

- การพิมพ์ข้อความลงตาราง
- การเลือกส่วนของตาราง
- การปรับขนาดของเซลล์
- การเพิ่มและลบแถว
- การเพิ่มและลบคอลัมน์
- การผสานเซลล์
- การแยกเซลล์
- การกำหนดเลันตาราง
- การกำหนดการแรงเงา

7 - การคัดเลือกผลงาน
- การสะท้อนความรู้สึกต่อผลงานของตนเอง
- การสร้างแฟ้มผลงานดีเด่น

8 - การคัดเลือกผลงาน
- การสะท้อนความรู้สึกต่อผลงานของตนเอง
- การสร้างแฟ้มผลงานดีเด่น
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แผนการสอน Microsoft Word 97 ครั้งที่ 2

จุดประสงค์

1. นักเรียนสามารถกำหนดรูปแบบตัวอักษร (Font) ได้
2. นักเรียนสามารถกำหนดขนาดตัวอักษร (Size) ได้
3. นักเรียนสามารถกำหนดลักษณะของตัวอักษร (Style) ได้
4. นักเรียนสามารถกำหนดสีตัวอักษระได้ (Color) ได้
5. นักเรียนสามารถจัดรูปแบบย่อหน้า (Alignment) ได้
6. นักเรียนสามารถตั้งกั้นหน้า และก้ันหลัง ได้
7. นักเรียนสามารถกำหนดระยะ Tab ได้

เนื้อหา

การจัดรูปแบบเอกสาร
การจัดรูปแบบเอกสาร ไม่ว่าจะเป็นการกำหนดรูปแบบตัวอักษร การกำหนดขนาด การ 

กำหนดลักษณะ และการกำหนดสีตัวอักษร ขันตอนแรกสุดจะต้องทำการเลือกข้อความที่ต้องการ 
แก้ไข โดยการเลือกข้อความมีวิธีการตังนี้

:̂ | Documentl

ฃั๋น เา m W าเขค ้ง ์ก ร ่า 'าน ั๊น  เ ท า จ ำ เ ป ีา เ พ ล ี๓ าไ เ& ฃ ล ่าน ใ[เท ่■ ร น จ าก น บ เท จ ึาฬ ค ่าส ์จ ํฃ อ ง  W o ld  เท อกาท นาไข 

ล่าบ*เนาเส ื-อกไ'5  ก า เท ล ีช ก & ]ค ว า ม ต ่า ง 'ไ น เ'เภ ร ๆ ? * า ม ูา « ท พ !!f t f i f i

1. Click mouse 
หน้าข้อความที่ตัองการ

นุ]ฒฒฒฒฒรร̂ .' I .

พ » พ * u fti» jr» s 'เวนน เท จ ่า lîki

1— 2. Drag mouse 
ทับข้อความที่ต้องการ 
จนหมดแล้วปล่อย

ณ”
เพ เ& ก ว ่า เก ํไ ร ๘วน ใรก ่อนจากน ันท^ใฯด ่าท ัพ »ง Word

><

ด่วนเท!.»สิอกฬ กาทรอภf e *  วามร่างไนเอก«ารร»ามา«เทีาใด่ไร่ย

การกำหนดรูปแบบตัวอักษร (Font)

1 Normal

1. Drag Mouse เลอกข้อความที 
ต้องการเปลี่ยนรูปแนบตัวอักษร

Angsana New Angsanalipc
'I Anal Black 'ดู? Arial Narrow •'ดู? BookAntiqua 'ดู? Bookman Old Style ดู? Bookshelf Symbol 3

- 2. Click mouse ทีลูกศร

3. Click mouse เสือกรูปแบบตัวอักษร ที่ต้องการ



106

การกำหนดขนาดตัวอักษร (Size)

» CordiaNew—-----------

1. Drag Mouse เลือกข้อความที่ 
ต้องการเปลี่ยนขนาดตัวอักษร

I

|,'PS

1 2. Click mouse ที่ลูกศร

3. Click mouse เลือกขนาดตัวอักษรที่ต้องการ

การกำหนดลักษณะตัวอักษร (Style)

1. Drag Mouse เลือกข้อความที ่
ต้องการเปลี่ยนลักษณะตัวอักษร

2.,หากต้องการตัวหนา ให้ Click Mouse ท่ีตัว B
14 -  IJb J  /  น  แ พ .3T หากต้องการตัวขีดเลันใต้ ให้ Click Mouse ท่ีตัว น

ห่ากต้องการตัว(อียง ให้ Click Mouse ท่ีตัว /

การกำหนดลักษณะตัวยก และตัวห้อย
1. Click Mouse ท่ีเม!;} Format

จ ุ P* พ » * "  ร  loo»» Tgbte a»
ว  û f ' ç j ' à a  y  ท'J A  เ ฐ ฐ ■ ■ ■ ■
ร ํพ ๊ฟ ๊ i î S S S ï i i r  f t  Eoragraph-

ะ- Bwllets and ÈJumbetirçj. 
Borders and Shading.,

2. เลือกคำลัง Font

จะปรากฏไดอะล็อกบ็อก Font

3. คลิกเพื่อทำเครื่องหมาย 
X ที Superscript เมือ 
ต้องการกำหนดลักษณะ 
ตัวยก

< ^ ๘ !  O A3. คลกเพอทาเครองหมาย
AX ท Subscript เมอ

1/ Oตองการกาหนดลกษณะ
<1ร 2ศตัวหอย
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การกำหนดสีตัวฟิกษร (Cnlnr)

2. Click mouse ท่ีลูกศร
1. Drag Mouse เลือกข้อความที่ 
ต้องการเปลี่ยนลืต้วอักษร

ร '
■  พเ *  ฒ a  น ■  ■
C  □  j ÿ g - B Ü  ■  5

3. Click mouse ท่ีสี 
ที่ต้องการ

การกำหนดรูปแบบย่อหน้า (Alignment)
เราสามารถจัดวางข้อความในเอกสาร โดยสามารถจัดให้ชิดด้านใดในด้านหน่ึงของ 

เอกสาร หรืออยู่กึ่งกลางหน้ากระดาษได้ ซึ่งการจัดข้อความนี้จะมีผลต่อข้อความในย่อหน้าทั้ง 
หมด โดยเราสามารถกำหนดการจัดวางตำแหน่งข้อความในเอกสารได้ดังนี้

การจัดชิดขอบซ้าย

1. Click Mouse ในย่อหน้าที่ต้องการ 2. Click Mouse ที่เครื่องมือจัดข้อความขัดซ้าย —g 4 f . i  ร ุเ  W Ê  M

■ jâ Document!

ท
I ป !น ก ท ! M ic ro so ft W o  r ป ีห ร ืฉ ท ื่ป ็ข ม เท /)ด ัน ๆ ว ่า  “W ord*  น น เป ีน โ ป ท เก !๚ ท ึม ึโ ว ส ำพ ัน ส ? 'ห พ /เส า^ ม ํว ่าจ ะ  
เป ีน ร จ ย ง าน จ ด ห ม า ย บ ัน ท ึก น ม ก ?ะ ท ั้V ท ?จ ัด ท ำห บ ัง ด ัฉ ก ํด า ม ^

3. จะไต้เอกลารขัดทางขอบซ้ายตามต้องการ

การจัดกึ่งกลาง

1. Click Mouse ในย่อหน้าทีต้องการ 2. Click Mouse ที่เครื่องมือจัดข้อความกึ่งกลาง
'tiâ Oocuraenll
ะ*''-1 - ป " ' ; ' . บ . ' .

เ?tarai
• ร • I • 7 • I • 8 • • 10 • I • 11 • I • 12 • I -13 •

ใ ป ท เก !^ M ic ro s o tt-W o rd y ร ีฉ ท ี่น ิยม tlh ราดันๆ-ว่า•“พ ord" น ั้น เป ีน โป !น ก ?มท ึม ึโซ ้สำพ ัช ส ?าน ฉ กส า?น !ว ่าจะ  
เป ็น ?าองาน จด ห มาย•บ ัน ท ึก น ม ก?ะท ั้!กา?จ ัด ท ำห น ัง& อก ตา!เไ เ

3. จะไต้เอกสารที่อยู่กึ่งกลางตามต้องการ

การจัดชิดขอบขวา

1. Click Mouse ในย่อหน้าที่ต้องการ 2. Click Mouse ที่เครื่องมือจัดข้อความขัดขวา

.บ:;:;บ • 1 ’ . 1 I : V 1-3 . : J ■ . 5 I 6 ■ I 7 ; I ; 3 I ■> . ■ 10 I ■ Ï1 . ; 13 . 13 ■ ■  บ. .<J|ห ^ ร BF*j

1 ป !น ก ?ม -M ic ro s o f t-W o rd M m น ิยม เร ียก ด ัน ๆ -ว ่า  " W o r d '- U ^ น โ ป ท เก ?ม ท ี่ม ีไว ส ำพ ับ ส ?าน ฉ ก ส าร ไม ่ว ่าจะ  

เป ็น ?ายงาน จด ห ม าย■ บ ัน ท ึกน ม ก?ะพ ั่ก า!จ ัด ท ำห น ั!ส ิฉ กตาม 'ไ!

3. จะได้เอกสารที่อยู่ขัดขวาตามต้องการ
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การจัดชิดขอบ

1. Click Mouse ในปอพน้าที่ต้องการ 2. Click Mouse ที่เครองมือจัดข้อความชิดขอบ
51 Document!__________________

ไปmกni-Microsoft-พ0ฬห1ฉท่ีนิอมเ?อกจันๆ-ว่า-"Word" uuithiîüftเกรนท่ี}Hoล่าห?ซarmอกสา?ไม่ว่าจะ: เป๋บ?าซงาบส«หมาอ-บันมกระาพารล่ดทำหบั}สือกัฅามใ!

3. จะได้เอกสารที่อยู่ชิดขอบตามต้องการ

Èrg I I

การจัดคำแบบไทย

1. Click Mouse ในย่อหน้าที่ต้องการ 2. Click Mouse ที่เครื่องมือจัดข้อความแบบไทย

ท '- - - — ..........................  ..........................  .......................................... t .................................................-------------------------------- 1บ**®"’ § ' ' ' ’ > =บ่ : ! ‘. ' ’• . . . 1. a . 1. *3

ขนตธนแก้ไขดังกล่าวน้ัน เ?าสำเป็นต้องเสือกว่าแก้ไฃล่วนใดก่อนสากน้ันเ?าจึงใข้คำล่งของ Word 
เ>4&กา?แก้ไขล่วบท่ีไต้เสือกไว้ กาทสือกข้อความต่างใบแa กสา?สามา?กทำไต้โดอ

3. จะได้เอกสารที่มือยู่ชิดขอบตามต้องการ

การต้ังก้ันหน้าและทนหลัง
การตั้งกันหน้าและกั้นหลังเป็นการช่วยกำหนดขอบเขตของข้อความในเอกสารไม่ให้เกิน HH 

ขอบเขตที่เราได้กำหนดไว้ การกำหนดขอบเขตให้กับข้อความในเอกสารมี 3 ประ๓ ท คือ ก้ันหน้า lisiliÉ
ก้ันหลัง JÜ และการกำหนดระยะในบรรทัดแรกของแต่ละย่อหน้า Ÿ

การท าหนดระยะในบรรทัดแรกของ แต่ละย่อหน้า
ก้ั 1 • I
กันห น'

K • 1 • 1 • 2 • • • 3 • 1 • 4 • 1 i • 8 • 1 7 • «พ̂-*«พพ.̂*'.--■ .-«พ-.ร*-.-.> -V ■1 • 8 • 1 • 9 • 1 • 10 • » • 11 • 1 • 12 • 1 • 13 • 1 • 14ร' m
กันหลัง ■

การกำหนดกั้นหน้า ก้ันหลัง และระยะในบรรทัดแรกของย่อหน้ามีข้ันตอนดังน้ี
1. Click Mouse ที่ย่อหน้าที่ต้องการกำหนด
2. เล่ือน Mouse ไปยังเครื่องมือ

Y1 หากต้องการกำหนดระยะในบรรทัดแรกของย่อหน้า

t  หากต้องการกำหนดกั้นหน้าของย่อหน้า 
■ Ü หากต้องการกำหนดกั้นหลังของย่อหน้า
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3. Drag Mouse เพื่อเลื่อนเครื่องมือต่างๆ ไปยังตำแหน่งที่ต้องการ

การกำหนดระยะในบรรทัดแรก
I M 1 • 1 ' 1 i- . : น . - •

: |
- I

i mî  
: 1

ร ิเท โ ฒ ิเร เ41

3 1 4 1 5 1 • 6 • 1 7 1 8 1 9 1 • 10 • 1 - น ■ 1 ช 1.พ- ' - 14 • • jH H B H T zl

โม่โพทิน 
ม่ระเภท

กางเงทันหนาและทันหลั*ป็นกาง«hยกำหนดขอบเขตของย้อควานโนเ'Zภลาร 
แอบเขตท่ีพาได้กำหนดไว กางกำหนดขอบเขตไห้ทับขอดวานโนเอกลางน็ 3 
เอ ทันหนา ทันหลัง และกางกำหนดงะยะโนบงงทัดแรกของแต่ละอ่■ อหนา

' 1 J j:

A. ■
ไ ! 1 *

_______ 1 217

การกำหนดระยะ Tab
การก ำห น ด ระยะ Tab เป็นการช่วยเพื่มความสะดวกในการกรอกข้อมูลในแต่ละบรรทัดให้ 

ตรงกัน ถ้าเรากดปม <Tab> 1 ครั้งจะทำให้ Cursor I เล่ือนไปเป็นระยะท่ีได้กำหนดไว้ ซ่ึงเร่ิมแรก 
แล้วระยะ Tab มีค่าเท่ากับ 0.5 นิว แต่เราลามารถกำหนดระยะ Tab นี้ได้ตามที่ต้องการ ซ่ึง Tab ท่ี 
ใช้บ่อยๆ ใน Word มี 4 ประ๓ ทดังน้ี

ร  Left Tab เป็นการกำหนดให้ต้นข้อความ (ด้านซ้าย) อยู่ในแนวเดียวกับ Left Tab
ซ่ึงการใช้ Tab น้ีมักจะใช้กับข้อความโดยทั่วๆ ไป

0  Right Tab เป็นการกำหนดให้ท้ายข้อความ (ด้านขวา) อยู่ในแนวเดียวกับ Right 
Tab ซึ่งการใช้ Tab นี้มักจะใช้กับข้อมูลจำพวกตัวเลข

H  Center Tab เป็นการกำหนดให้กึงกลางของข้อความอยู่ในแนวเดียวกับ Center Tab 
HI Decimal Tab เป็นการกำหนดให้จุดทศนิยมอยู่ในแนวเดียวกับ Decimal Tab ซ่ึงการ 

ใช้ Tab นี้เหมาะ ลำหรับการเรียงตัวเลขให้จุดทศนิยมตรงกัน 
วิธีการกำหนดระยะ Tab ทำได้ดังน้ี

1. Click mouse เลือกรูปแบบ โดยจะเปลี่ยนไปทีละแบบเมื่อ Click mouse

2. Click mouse ตรงตำแหน่งท่ีต้องการต้ัง Tab หากไม่พอใจลามารถย้ายได้โดยการ Drag Mouse เลือน 
Tab ไปยังตำแหน่งใหม่ และหากต้องการลบทิ้งให้ Drag Mouse เลือน ออกมานอก Ruler

Left Tab
A

Center Tab Decimal Tab Right Tab
. fp.  3 .■ 1 .;4 • 1 ' 5 ' 1 ' 7 ' j l:  8 : fjเะา • 1 0 • ' ' l l ■ 6 J)  • 1 ; 13 ■ '

ภ า ค ก ล า ง ขทฺว 4 5 3 4 2 73 ล า น ต ัน

ภ าค 'ไต ม ัน ล ัน ป ะ ห ล ัง 5 4 6 .76 ล ัา น ต ้น

ภ า ค เห น ือ ล ิ้น ฺจ ี่ 4 2 2 .39 ล า น ต น

........................ ■ : ■ .TÔT:ใ-:'■ _ |
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ช้ันนำ
ครูให้นักเรียนเปิดโปรแกรม Microsoft Word 97
ครูแลดงชิ้นงานตัวอย่าง 2 ช้ิน ให้นักเรียนดู (ช้ินงานมีความแตกต่างกันตรงท่ีช้ินหน่ึง 

มีการกำหนดรูปแบบ อีกช้ินหน่ึงไม่มีการกำหนดรูปแบบ) และถามว่า “นักเรียนคิดว่าเอกสาร 2 
ซินนี ชินใดมีความสวยงาม และน่าสนใจกว่ากัน”

เมื่อนักเรียนตอบจบ ครูกลาวว่า “นักเรียนจะเห็นว่า การกำหนดรูปแบบช่วยสร้าง 
ความสวยงาม และน่าสนใจให้แก่เอกสาร ซึ่งในวันนี้เราจะมาสืกษากันว่า การกำหนดรูปแบบให้ 
แก'เอกสารมีวิธีการอย่างไรบ้าง”

ช้ันสอน
ครูกล่าวว่า “ก่อนที่เราจะทำการจัดรูปแบบเอกสารหรีอตกแต่งเอกสารให้สวยงามนั้น เรา 

ต้องทำการกำหนดก่อนว่าข้อความล่วนใดที่เราต้องการจัดรูปแบบ โดยมีวิธีการกำหนดตังน้ี" ครู 
แสดงให้นักเรียนดู และให้นักเรียนปฏิบัติตาม

1. Click Mouse หน้าข้อความล่วนท่ีต้องการกำหนดรูปแบบ
2. D rag  Mouse ทับข้อความที่ต้องการจนหมดแล้วปล่อย

ครูกล่าวเพิ่มเติมว่า “ข้อความล่วนที่มีการเลือก จะเป็นแถบลืดำ หลังจากที่ทำการเลือก 
แล้ว ก็จะเป็นชั้นตอนการกำหนดรูปแบบเอกสาร โดยมีวิธีการต่างๆ ตังน้ี” ครูแสดงให้นักเรียนดู 
และให้นักเรียนปฏิบัติตาม

การกำหนดรูปแบบตัวอักษร สามารถทำได้โดย
า . D rag  Mouse เลือกข้อความที่ต้องการกำหนดรูปแบบตัวอักษร
2. เลือน Mouse ไปยังแถบเครืองมีอ Formatting Toolbar
3. C lick Mouse ท่ีลูกศร
4. C lick  Mouse เลือกรูปแบบตัวอักษรที่ต้องการ 

การกำหนดขนาดตัวอักษร ลามารถทำไดโดย
1. D rag  Mouse เลือกข้อความท ี่ต้องการกำหนดขนาดตัวอักษร
2. เลือน Mouse ไปยังแถบเครื่องมือ Formatting Toolbar
3. C lick  Mouse ท่ีลูกศร
4. C lick  Mouse เลือกขนาดตัวอักษรที่ต้องการ 

การกำหนดลักษณะตัวอักษร
1. D rag  Mouse เลือกข้อความที่ต้องการกำหนดลักษณะตัวอักษร



2. เลือน Mouse ไปยังแถบเครืองมือ Formatting Toolbar
3. Click Mouse ท่ีตัว B เมื่อต้องการทำตัวหนา
4. Click Mouse ท่ีตัว I เมื่อต้องการทำตัวเอียง
5. Click Mouse ท่ีตัว y  เมื่อต้องการทำตัวขีดเลันใต้
6. Click Mouse เลือกขนาดตัวอักษรที่ต้องการ 

การกำหนดตัวยกและตัวห้อย สามารถทำได้โดย
1. Click Mouse ทีเมนู Format
2. เลือกคำลัง Font
3. คลิกเพื่อทำเครื่องหมาย X ท่ี Superscript เมื่อต้องการกำหนดลักษณะตัวยก 

หรือคลิกท่ี Subscript เมื่อต้องการกำหนดลักษณะตัวห้อย
การกำหนดสีตัวอักษร สามารถทำได้โดย

1. Drag Mouse เลือกข้อความที่ต้องการเปลี่ยนสีตัวอักษร
2. Click Mouse ท่ีลูกศร
3. Click Mouse ทีสท่ีต้องการ

ครูกล่าวว่า “ขั้นต่อไปเราจะมาเรียนรู้วิธีการจัดวางตำแหน่งข้อความ โดยที่การจัดวาง 
ข้อความนี้จะล่งผลต่อย่อหน้านั้นทั้งหมด ซึ่งมีวิธีการดังนี้,, ครูแสดงให้นักเรียนดู และให้นักเรียน 
ปฏิบัติตาม

1. Click Mouse ในย่อหน้าที่ต้องการ
2. Click Mouse ที่เครื่องมือจัดข้อความที่ต้องการ

- Click Mouse ที่เครื่องมือจัดข้อความชิดซ้าย เมื่อต้องการจัดข้อความ 
ชิดซ้าย

- Click Mouse ที่เครื่องมือจัดกึ่งกลาง เมื่อต้องการจัดข้อความให้อยู่กึ่ง 
กลางหน้ากระดาษ

- Click Mouse ที่เครื่องมือจัดข้อความชิดฃวา เมื่อต้องการจัดข้อความ 
ชิดขวา

- Click Mouse ที่เครื่องมือจัดข้อความชิดขอบ เมื่อต้องการจัดข้อความ 
ให้ชิดขอบท้ังสองด้าน

- Click Mouse ที่เครื่องมือจัดข้อความแบบไทย เมื่อต้องการจัดข้อความ 
แบบไทย

ค ร ูก ล ่า ว ว ่า  “ใ น ก า ร พ ิม พ ์เอ ก ส า ร น ั้น  เร า ล า ม า ร ถ ก ำ ห น ด ร ะ ย ะ ห ่า ง ร ะ ห ว ่า ง ข อ บ ข ้อ ค ว า ม

ก ับ ข อ บ ก ร ะ ด า ษ ไ ด ้ ซ ึ่ง เร า เร ีย ก ว ่า  ก า ร ต ั้ง ก ั้น ห น ้า แ ล ะ ก ั้น ห ล ัง  โ ด ย ข อ บ ท า ง ด ้า น ซ ้า ย เร า เร ีย ก ว ่า
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ก้ันหน้า และขอบด้านขวาเราเรียกว่ากั้นหลัง ซึ่งมีวิธีการกำหนดดังนี้’' ครูแสดงให้นักเรียนดู และ 
ให้นักเรียนปฏิบัติตาม

1. Click Mouse ที่ย่อหน้าที่เราต้องการกำหนด
2. เล่ือน Mouse ไปยังเครองมือที่ต้องการ
3. Drag Mouse เพื่อเลื่อนเคร่ืองมือน้ันไปยังตำแหน่งที่ต้องการ

ครูแสดงตัวอย่างงานให้นักเรียนดู (ชินงานมีการกำหนด Tab เพ่ือทำให้ข้อความตรงกัน) 
และถามว่า “นักเรียนคิดว่า เราจะทำอย่างไรเพื่อที่จะพิมพ์เอกสารนี้ได้อย่างสะดวก รวดเร็ว โดย 
พิมพ์ข้อมูลแต่ละบรรทัดได้ตรงกัน เป็นระเบียบ สวยงาม"

เมื่อนักเรียนตอบจบ ครูกล่าวว่าเพิ่มเติมว่า “การกำหนด Tab จะเพิ่มความสะดวกใน 
การพิมพ์ข้อมูลแต่ละบรรทัดได้อย่างสะดวก รวดเร็ว เป็นระเบียบ สวยงาม เมื่อเรากดปุม 
<Tab> 1 คร้ัง จะทำให้ Cursor (I) เล่ือนไปเป็นระยะท่ีได้กำหนดไว้ โดยค่าเร่ิมต้นของโปรแกรม 
ระยะ Tab จะมีค่าเท่ากับ 0.5 น้ิว แต่นักเรียนสามารถกำหนดระยะ Tab ได้ตามต้องการ ซ่ึง 
Tab ทีนิยมใข้ใน Microsoft Word มี 4 ประเภทคือ Left Tab 1 Right Tab , Center Tab และ 
Decimal Tab"

ครูอธิบายวิธีการกำหนด Tab โดยกล่าวว่า “นักเรียนลามารถกำหนด Tab ได้ดังน้ี" ครู 
อธิบายพร้อมทั้งให้นักเรียนปฏิบัติตาม

1. Click Mouse เลือกรูปแบบที่มุมบนซ้ายมือของหน้าต่างเอกสาร โดยรูปแบบ 
Tab จะเปล่ียนไปทีละแบบ

2. Click Mouse ตรงตำแหน่งท่ีต้องการตั้ง Tab
3. หากไม่พอใจลามารถย้ายได้โดยการ Drag Mouse เล่ือน Tab ไปยังตำแหน่ง 

ใหม่ และหากต้องการลบทิ้งให้ Drag Mouse เล่ือนออกมานอกไม้บรรทัด 
(Ruler) ทางด้านซ้าย

ครูสรุปว่า “จากการปฏิบัตินักเรียนจะพบว่า”
- Left Tab เป็นการกำหนดให้ต้นข้อความด้านซ้าย อยู่ในแนวเดียวกับ Left Tab 

ซ่ึงการใช้ Tab น้ี มักจะใช้กับข้อความท่ัวๆ ไป
- Right Tab เป็นการกำหนดให้ท้ายข้อความด้านขวา อยู่ในแนวเดียวกับ Right 

Tab ซ่ึงการใช้ Tab น้ี มักจะใช้กับข้อมูลจำพวกตัวเลข
- Center Tab เป็นการกำหนดให้กึ่งกลางของข้อความอยู่ในแนวเดียวกับ Center 

Tab
Decimal Tab เป็นการกำหนดให้จุดทศนิยมอยู่ในแนวเดียวกับ Decimal Tab 
ซึ่งการใช้ Tab น้ี เหมาะสำหรับการเรียงตัวเลขให้จุดทศนิยมตรงกัน
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ข้ันสรุป
ครูกล่าวสรุปว่า “การจัดรูปแบบเอกสารด้วยการกำหนดรูปแบบตัวอักษร ขนาด ลักษณะ 

และสีตัวอักษร รวมไปถึงการจัดรูปแบบย่อหน้า จะทำให้เอกสารท่ีนักเรียนสร้างข้ึนน่าสนใจ อ่าน 
ง่าย และเป็นระเบียบเรียบร้อย โดยการกำหนดนักเรียนสามารถกำหนดได้จากแถบเครื่องมือ 
Formatting Toolbar หรือกำหนดจากเมนู Format" ครูให้นักรียนซักถามข้อลงลัย และให้ 
เพ่ือน  ๆ ช่วยกันตอบข้อซักถามที่เพื่อนตั้งขึ้นมา และครูกล่าวเสรีมในล่วนท่ีขาดไป

ขั้นสร้างผลงาน รวบรวมผลงาน และแกไขผลงาน
1. แบบผู้เรียนมีโอกาสในการเลือกสร้างผลงาน

1.1 ครูแสดงเอกสารตัวอย่างชิ้นงานประจำสัปดาห์ จำนวน3 ช้ิน ให้นักเรียนดู 
และนำเสนอ URL ที่นักเรียนลามารถดูตัวอย่างชิ้นงานได้จาก World 
Wide Web

1.2 ครูให้นักเรียนสร้างงานตามเอกสารที่แจกให้ โดยเลือกทำ 1 ช ิ้น จาก 3 ช้ิน 
และให้ทำเป็นการบ้าน

1.3 ครูให้นักเรียนให้คำแนะนำในผลงานของเพ่ือน (ผลงานในสัปดาห์ก่อน)
1.4 ครูให้นักเรียนปรับปรุงแก้ไขผลงานในสัปดาห์ก่อน โดยวิเคราะห์ตามคำแนะ 

นำของครูและเพื่อน
2. แบบผู้เรียนไม่มืโอกาสในการเลือกสร้างผลงาน

2.1 ครูแสดงเอกสารตัวอย่างชิ้นงานประจำสัปดาห์ จำนวน 1 ช้ิน ให้นักเรียนดู 
และนำเสนอ URL ที่นักเรียนสามารถดูตัวอย่างชิ้นงานได้จาก World 
Wide Web

2.2 ครูให้นักเรียนสร้างงานตามเอกสารที่แจกให้ โดยให้ทำเป็นการบ้าน
2.3 ครูให้นักเรียนให้คำแนะนำในผลงานของเพ่ือน (ผลงานในสัปดาห์ก่อน)
2.4 ครูให้นักเรียนปรับปรุงแก้ไขผลงานในสัปดาห์ก่อน โดยวิเคราะห์ตามคำ 

แนะนำของครูและเพ่ือน

ข้ันประเมินผล
1. ครูประเมินผลนักเรียนด้วยแบบทดสอบหลังเรียน (ประเมินผลด้วยแบบทดสอบหลัง 

เรียน โดยทดสอบหลังเรียนจบบทเรียนสุดท้ายแล้ว)
2. ครูประเมินผลงานของนักเรียนด้วยเกณฑ์การประเมินผลงานแบบ Rubric (ประเมิน 

ผลงานในแฟ้มผลงานดีเด่น เมื่อสืกษาครบ 8 คร้ัง)



ภาคผนวก ฌ
ใบงาน ต้วอย่างผลงาน และเกณฑ์การประเมินผลงาน



ใบ งาน  ครั้งที่ 1 (สำหร ับน ักเร ียนกล ุ่มท ี่ม ืโอกาสในการเล ื'อกสร ้างผลงาน)
ให้นักเรียนใช้ความรู้ที,เรียนในสัปดาห์น้ี สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยเลือกปฏิบัติงาน 1 ช้ิน จาก 3 ช้ินต่อไปน้ี
1. บทกลอนที่ประทับใจ โดยมีข้อกำหนดด้งนี้

- พิมพ์ประว่ติส่วนตัว ซ่ึงมีข้อมูลต่อไปน้ี (ซ่ือ -  นามสกุล 1 ช้ัน 1 โรงเรียน 1 
วันเกิด และท่ีอยู่)

- พิมพ์บทกลอนที่นักเรียนประทับใจ พร้อมท้ังช่ือผู้แต่ง
- พิมพ์ความรู้ที่นักเรียนนำมาใช้ในการปฏิบัติงานครั้งนี้
- ใช้ความรู้ท่ีเรียนในสัปดาห์น้ีตกแต่งเอกสารช้ินนี้ให้สวยงาม
- เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Klon1.Doc

2. นิทานที่ประทับใจ โดยมีข้อกำหนดด้งนี้
- พิมพ์ประวัติส่วนตัว ซ่ึงมีข้อมูลต่อไปน้ี (ช่ือ -  นามสกุล 1 ช้ัน 1 โรงเรียน ,

วันเกิด และท่ีอยู่)
- พิมพ์นิทานที่นักเรียนประทับใจ พร้อมท้ังช่ือผู้แต่ง
- พิมพ์ความรู้ที่นักเรียนนำมาใช้ในการปฏิบัติงานครั้งนี้
- ใช้ความรู้ท่ีเรียนในสัปดาห์น้ีตกแต่งเอกสารช้ินนี้ให้สวยงาม
- เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Nitan1.Doc

3. เพลงที่ประทับใจ โดยมีข ้อกำหนดดังนี้
- พิมพ์ประวัติส่วนตัว ซ่ึงมีข้อมูลต่อไปน้ี (ช่ือ -  นามสกุล 1 ช้ัน 1 โรงเรียน 1 

วันเกิด และท่ีอยู่)
- พิมพ์เพลงที่นักเรียนประทับใจ พร้อมท้ังช่ือติลปิน
- พิมพ์ความรู้ที่นักเรียนนำมาใช้ในการปฏิบัติงานครั้งนี้
- ใช้ความรู้ท่ีเรียนในสัปดาห์น้ีตกแต่งเอกสารช้ินนี้ให้สวยงาม
- เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ซ่ือแฟ้มข้อมูลว่า Song1.Doc



ใ บ ง า น  ค ร ั้ง ท ี่ 1 ( ส ำ ห ร ับ น ัก เ ร ีย น ก ล ุ่ม ท ี่ไ ม ่ม ีโ อ ก า ส ใ น ก า ร เ ล ือ ก ส ร ้า ง ผ ล ง า น )

ให้นักเรียนใช้ความรู้ท่ีเรียนในสัปดาห์นี้ สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 
โดยปฏิบัติ'งาน นิทานที่ประนับใจ ที่งมีข้อกำหนดด้งนี้

- พิมพ์ประวัติส่วนตัว ซ่ึงมีข้อมูลต่อไปน้ี (ช่ือ -  นามลกุล 1 ช้ัน 1 โรงเรียน 1 
วันเกิด และท่ีอยู่)

- พิมพ์นิทานที่นักเรียนประทับใจ พร้อมท้ังช่ือผู้แต่ง
- พิมพ์ความรู้ที่นักเรียนนำมาใช้ในการปฏิบัติงานครั้งนี้
- ใช้ความรู้ท่ีเรียนในสัปดาห์น้ีตกแต่งเอกสารช้ินนี้ให้สวยงาม

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Nitan1.Doc



ป ร ะ ว ้ฅ ส ่ว น (ท อ
ซีเอ ด.ซ. เก่ง ขยันเรียน
ชั้น ม. 1/2 เลขท่ี 10
โรงเรียน สาธิตจุฬาลงกรณ์มหาวิทยาลัย ฝ่ายมัธยม
วันเกิด 1 0 มกราคม 2526
ที่อยู่ 23/24 ซอยวชิรธรรมสาธิต14 ถนนสุขุมวิท เขตบางนา แซวงบางนา กรุงเทพฯ
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ก ล อ น ท ี่ป ร ะ ท ับ ใ จ
เด ็ก ด ี

เด็กดคอเด็กทรูลักคด 
ใฝ่ความรู้คู่การเล่นที่งดงาม 

เลือกทำดีจะมีแต่ความสุข 
คุมให้ได้ท้ังเล่นท้ังการเรียน

ยามอยู่บ้านช่วยงานพ่อแม่ลัง 
มีการบ้านรีบทำอย่ารั้งรอ 

เกิดมาได้ทั้งทีต้องรู้ค่า 
เร่งดำรงคุณธรรมความเป็นคน

ความดีงามจะเกิดได้ต้องหมั่นทำ 
หมั่นดูแลความสะอาดปัดที่นอน 

รู้จักรักดีลปะการสร้างสรรค์ 
การสร้างสรรค์ต้องทำด้วยความเพียร

รู้ถูกผิดมุ่งม่ันหม่ันไต่ถาม 
ทุกโมงยามรู้เล่นรู้รักเรียน 
ความสนุกต้องคุมกุมบังเหียน 
ความพากเพียรเป็นที่ตั้งอย่ารั้งรอ 
อย่ามัวม่ังดูทีวีตีหน้ป๋อ 
เพื่อจะก่อความรู้มาล่ตน 
รู้จักพาชีพไปไม่ลับลน 
ให้เปียมล้นด้วยความดีท่ีแน่นอน 
ต้องจดจำส่ิงดีท่ีครูสอน 
ก่อนจะจรจากบ้านไปโรงเรียน 
ทุกทุกวันร้องเพลงหัดวาดเขียน 
เป็นนักเรียนท่ีดีมีสุขเอย

ประเท ือง เอมเจร ิญ

ค ว า ม ร ู้ท ี่น ำ ม า ใ ช ้ใ น ก า ร ป ฎ ิบ ้ผ ัง า น
การกำหนดรูปแบบตัวอักษร 1 การกำหนดขนาดตัวอักษร , การกำหนดลักษณะตัวอักษร 1 

การกำหนดสิตัวอักษร 1 การจัดรูปแบบย่อหน้า 1 การตั้งกั้นหน้า ก้ันหลัง และการกำหนด Tab



ป ร ะ ว ้ต ัส ่ว น ฅ ว
รีรอ ด.ซ. เก่ง ขยันเรียน
ชน ม. 1/2 เลขท่ี 10
โรงเรียน สาธิตจุฬาลงกรณ์มหาวิทยาลัย ฝ่ายมัธยม 
ว้นเกิด 1 0 มกราคม 2526
ที่อยู่ 23/24 ซอยวซิรธรรมสาธิต14 ถนนสุขุมวิท เขตบางนา แขวงบางนา กรุงเทพ
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น ิท า น ท ี่ป ร ะ ท บ ใ จ

บ ท เ ร ีย น ข อ ง ค น เ ห ็น แ ก ่ไ ด ้

ชายลองคน เดินทางมาด้วยกัน มาถึงหมู่บ้านแห่งหนึ่ง พวกเขาก็เห็นขวานเล่ม 
หน่ึงตนอยู่มันพ้ืน ชายคนท่ีหน่ึงพูดข้ึนว่า "พวกเราเจอขวานเข้าแล้วซี !”

ชายคนที่สองรีบพูดขัดคอว่า "ไม่ใช่” พวกเรา "ดอกที่เจอขวาน แต่ฉันต่างหาก 
เป็นคนเจอขวาน’’

พูดพลางเก็บขวานขึ้นมาเหน็บเอวไว้ คล้ายกับกลัวชายคนที่หนึ่งจะเข้ามาเอี่ยว 
ส่วนแบ่ง ชายคนท่ีหน่ึงน่ึงมองโดยไม,ปริปากพูดว่ากระไร

พวกเขาเดินทางต่อไปได้ไม่นานนัก ก็มีซาวบ้านคนหน่ึงว่ิงไล่กวดมา พร้อมกับ 
ร้องตะโกนข้ึนว่า '‘ไอ้หัวขโมย แกจะเอาขวานของฉันไปไหน ?"

ชายคนที่สองตกไจมาก พูดกับชายคนที่หนึ่งว่า “แย่แล้ว ! เขามาเอาเรื่องพวก
เราแล้ว"

ชายคนที่หนึ่งตอบอย่างเย็นชาว่า “เขามาเอาเรื่อง “แก" ต่างหาก ไม่ใช่ “พวก
เรา””

ร ถ ย า  ส า ร ธ ร ร ม  ะ แ ป ล แ ล ะ เ ร ีย บ เ ร ีย ง

ค วาม ร ัก น ำม าใช ้ใน ก ารป ฏ ิน ํต ัง าน
ก า ร ก ำ ห น ด ร ูป แ บ บ ต ัว อ ัก ษ ร  1 ก า ร ก ำ ห น ด ข น า ด ต ัว อ ัก ษ ร  1 ก า ร ก ำ ห น ด ล ัก ษ ณ ะ ต ัว อ ัก ษ ร  ,

ก า ร ก ำ ห น ด ส ีต ัว อ ัก ษ ร  1 ก า ร จ ัด ร ูป แ บ บ ย ่อ ห น ้า  1 ก า ร ต ัง ก ัน ห น ้า  ก ัน ห ล ัง  แ ล ะ ก า ร ก ำ ห น ด  T a b



ป ร ะ ว ้ต ัส ่ว น ผ ัว
ท่ีอ ด.ซ. เก่ง ขยันเรียน
ชั้น ม. 1/2 เลขท่ี 10
โรงเรียน สาธิตจุฬาลงกรณ์มหาวิทยาลัย ฝ่ายมัธยม 
วันเกิด 1 0 มกราคม 2526
ที่อยู่ 23/24 ซอยวซิรธรรมสาธิต14 ถนนสุขุมวิท เขตบางนา แขวงบางนา กรุงเทพ 
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โ พ ล ง ท ี่ป ร ะ ผ ับ ใ จ

ต ้น ไ ม ้ข อ ง พ ่อ

ดิลปิน : เบิร์ด ธงไชย แมคอินไตย์
นานมาแล้ว พ่อได้ปลูกต้นไมไวิให้เรา เพ่ือวันหน่ึงจะบัง ลมหนาว 

และคอยเป็นร่มเงา ปลูกไว้เพ่ือพวกเรา ทุก  ๆ คน 
พ่อใช้เหง่ือ แทนน้ํารดลงไป เพื่อจะผลิดอกไบออกผล 
ให้เราทุก  ๆ คนเติบโตอย่างร่มเย็น ในบ้านเรา

ผ่านมาแล้วห้าสิบปี ต้นไม้น้ันสูงใหญ่ ลมแรงเท่าไร ก็บรรเทา 
ออกผลให้เก็บกิน แตกใบเพ่ือให้ร่มเงา คอยดูแลเรา ให้เรายังมีวัน อยู่ต่อไป 
จนวันน้ี ใต้เงาแห่งต้นไม้ ต้นใหญ่ ลูกไต้อยู่ได้คอยอาศัย 
แผ่นดินยังกว้างไกล แต่เหมือนว่าหัวใจ พ่อกว้างกว่า

ลูกที่เกิดตรงนี้น้ันยังอยู่ และยังอยู่เพื่อคอยรักษา 
จะรวมใจเข้ามา จะมีที่สัญญา ในหัวใจ
จากวันน้ีลักหม่ืนปี ต้นไม้ท่ีพ่อปลูก ต้นสวยนั้งงดงาม และยิ่งใหญ่ 
ลืบลานและติดตาม จากรอยที่พ่อตั้งใจ เมื่อเราจะเทไป ให้ต้นไม้ ของพ่อ ยังงดงาม 

จากวันน้ีลักหม่ืนปี ต้นไม้ท่ีพ่อปลูก ต้นสวยทั้งงดงาม และยิ่งใหญ่ 
ลืบลานและติดตาม จากรอยที่พ่อตั้งใจ เมื่อเราจะเทไปจากหัวใจ 
เพ่ือเราจะเทไป ให้ต้นไม้ ของพ่อ ยังงดงาม

ค วาม ธ ู้ท ี่น ำม าใซ ัใน การป ฎ ิน ํต ังาน
ก า ร ก ำ ห น ด ร ูป แ บ บ ต ัว อ ัก ษ ร  1 ก า ร ก ำ ห น ด ข น า ด ต ัว อ ัก ษ ร  1 ก า ร ก ำ ห น ด ล ัก ษ ณ ะ ต ัว อ ัก ษ ร  ,

ก า ร ก ำ ห น ด ล ืต ัว อ ัก ษ ร  1 ก า ร จ ัด ร ูป แ บ บ ย ่อ ห น ้า  1 ก า ร ต ั้ง ก ั้น ห น ้า  ก ั้น ห ล ัง  แ ล ะ ก า ร ก ำ ห น ด  T a b



เกณ ฑ ์การป ระเม ิน ผลงาน  ครั้งที่ 1
จุดประสงค์ของกิจกรรม

1. การกำหนดรูปแบบตัวอักษร (Font)
2. การกำหนดขนาดตัวอักษร (Size)
3. การกำหนดลักษณะของตัวอักษร (Style)
4. การกำหนดสีตัวอักษร (Color)
5. การจัดรูปแบบย่อหน้า (Alignment)
6. การตั้งกั้นหน้า และก้ันหลัง
7. การกำหนดระยะ Tab

ป ร ะ เด ็น ป ร ะ เม ิน 4 (ด ีเย ี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
ผลงานครบถ้วน 
และถูกต้อง

- ครบถ้วนและถูกต้องท้ัง 7 
จุดประสงค์

- ครบถ้วนและถูกต้อง 5 ใน 7 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 3 ใน 7 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 
น้อยกว่า 3 จุดประสงค์

การปฏิบัติตามข้อ 
กำหนด

- มีประวัติส่วนตัว
- มีบทกลอน หรอ นิทาน หรอ 

เพลงท่ีประทับใจ พร้อมท้ังซ่ือผู้ 
แต่งหรือคิเลปีน

- มีการพิมพ์ความร้ที่นำมาใช้ใน 
การปฏิบัติงาน

- เอกสารมีความยาวไม่น้อยกว่า 
หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลโดยใช้ซ่ือได้ 
อย่างถูกต้อง

- ปฏิบัติ 4 ใน 5 ข้อ - ปฏิบัติ 3 ใน 5 ข้อ - ปฏิบัติน้อยกว่า 3 ข้อ



ประเด็นประเมิน 4 (ด ีเยี่ยม) 3 :ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
ความสวยงาม 
และการจัดวาง 
องค์ประกอบ

- มีการเน้นข้อความหัวข้อด้วยตัว 
หนา ขีดเส์นใต้ หรือตัวเอียง

- มีการใช้สีตัวอักษรเน้นหัวข้อ 
หรือข้อความสำคัญ

- มีการจัดวางองค์ประกอบอย่าง 
สมดุล

- ปฏิบัติ 2 ใน 3 ข้อ - ปฏิบัติ 1 ใน 3 ข้อ - ไม่ปฏิบัติท้ัง 3 ข้อ

หมายเหตุ คะแนนเต็ม 4 คะแนน



ใบ งาน  คร ั้งท ี่ 2 (ส ำห ร ับ น ัก เร ียน ก ล ุ่ม ท ี่ม ีโอ ก าส ใน ก าร เล ือ ก ส ร ้างผ ล งาน )
ให้นักเรียนใช้ความรู้ที่เรียนในสัปดาห์นี้ สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยเลือกปฏิบั!ติ-งาน1 ช้ิน จาก 3 ช้ินต่อไปน้ี
1. เมนู,อาหารของร้านอาหาร โดยมีข้อกำหนดดังนี้

- พิมพ์รายการอาหารประเภทต่างๆ โดยแทรกสัญลักษณ์หน้าหัวข้อแบบ 
กำหนดเอง (Customize)

- พิมพ์รายการอาหารจานโปรด โดยแทรกลำดับเลข และปรับแต่งแบบ 
อักษรของลำดับเลข

- แทรกรูปวาด และตกแต่งให้สวยงาม (Fill Color 1 Line Color 1 Line style)
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Food 1.Doc

2. รายการหนังลือของร้านขายหนังลือ โดยมีข้อกำหนดดังนี้
- พิมพ์รายการหนังลือประเภทต่างๆ โดยแทรกสัญลักษณ์หน้าหัวข้อแบบ 

กำหนดเอง (Customize)
- พิมพ์รายการหนังลือที่ประนับใจ โดยแทรกลำดับเลข และปรับแต่งแบบ 

อักษรของลำดับเลข
- แทรกรูปวาด และตกแต่งให้สวยงาม (Fill Color 1 Line Color 1 Line style)
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Book1.Doc

3. รายการภาพยนตร์ของร้านเช่าวีดีโอ โดยมีข้อกำหนดดังนี้
- พิมพ์รายการภาพยนตร์ประเภทต่างๆ โดยแทรกสัญลักษณ์หน้าหัวข้อ 

แบบกำหนดเอง (Customize)
พิมพ์รายการภาพยนตร์ที่ประนับใจ โดยแทรกลำดับเลข และปรับแต่ง 
แบบอักษรของลำดับเลข

- แทรกรูปวาด และตกแต่งให้สวยงาม (Fill Color 1 Line Color 1 Line style)
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4 
บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Movie1.Doc



ใบ งาน  คร ั้งท ี่ 2 (ส ำห ร ับ น ัก เร ียน ก ล ุ่ม ท ี่ไม ่ม ีโอ ก าส ใน ก ารเส ือ ก ส ร ้างผ ล งาน )
ให้นักเรียนใช้ความรู้ที่เรียนในสัปดาห์น้ี สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยปฏิบัติงาน รายการหนังสือของร้านจำหน่ายหนังสือ สืงมีข้อกำหนดด้งนี้
- พิมพ์รายการหนังสือประเภทต่างๆ โดยแทรกสัญลักษณ์หน้าหัวข้อแบบ 

กำหนดเอง (Customize)
- พิมพ์รายการหนังสือที่ประทับใจ โดยแทรกลำดับเลข และปรับแต่งแบบ 

อักษรของลำดับเลข
- แทรกรูปวาด และตกแต่งให้สวยงาม (Fill Color 1 Line Color, Line style)
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 Style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน•โดยใช้ซื่อแฟ้มข้อมูลว่า Book1.Doc
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เก ณ ฑ ์ก าร ป ร ะ เม ิน ผ ล ง าน  คร ั้งท ี่ 2
จุดป?ะสงค์ของกิจท?รม

1. การแทรกสัญลักษณ์แสดงหัวข้อย่อย
2. การแทรกลำดับเลข
3. การแทรกรูปวาด
4. การกำหนดสีให้กับรูปวาด

ประเด็นประเมิน 4 (ด ีเย ี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
ผลงานครบถ้วน 
และถูกต้อง

- ครบถ้วนและถูกต้องท้ัง 4 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 3 ใน 4 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 2 ใน 4 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 
น้อยกว่า 2 จุดประสงค์

การประยุกต์ใช้ - ใช้สัญลักษณ์แสดงหัวข้อย่อย 
แบบกำหนดเอง

- มีการปรับแต่งแบบอักษรของ 
ลำดับเลข

- มีการปรับแต่งรูปวาด โดย 
กำหนดสีเติม (Fill Color)

- มีการปรับแต่งรูปวาด โดย 
กำหนดสีเสัน (Line Color)

-  มีการปรับแต่งรูปวาด โดย 
กำหนดรูปแบบของเสัน (Line 
Style)

- ปฏิบัติ 4 ใน 5 ข้อ - ปฏิบัติ 3 ใน 5 ข้อ - ปฏิบัติน้อยกว่า 3 ข้อ



ประเด็นประเมิน 4 (ด ีเย ี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
การปรับแต่งย่อ 
หน้า และข้อความ

- มีการกำหนดรูปแบบตัวอักษร 
(Font) ที่เหมาะสมกับเอกสาร

- มีการกำหนดขนาดตัวอักษร 
(Size) ที่เหมาะสมกับเอกสาร

- มีการกำหนดลักษณะของตัว 
อักษร (Style) ที่เหมาะสมกับ 
เอกสาร

-  มีการกำหนดสืของตัวอักษร 
(Color) ที่เหมาะสมกับเอกสาร

- มีการลัดรูปแบบย่อหน้า ท่ีเป็น 
ระเบียบเรียบร้อย

- ปฏิบัติ 4 ใน 5 ข้อ - ปฏิบัติ 3 ใน 5 ข้อ -  ปฏิบัติน้อยกว่า 3 ข้อ

การปฏิบัติตามข้อ 
กำหนด

- มีการพิมพ์รายการอาหาร หรือ 
รายการหนังสือ หรือุ รายการ 
ภาพยนตร์

-  มีการพิมพ์รายการอาหารจาน 
โปรด หรือ รายการหนังสือ หรือ 
รายการภาพยนตร์ที่ประทับใจ

- เอกสารมีความยาวไม่น้อยกว่า 
หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลโดยใช้ซ่ือได้ 
อย่างถูกต้อง

- ปฏิบัติ 3 ใน 4 ข้อ - ปฏิบัติ 2 ใน 4 ข้อ - ปฏิบัติน้อยกว่า 2 ข้อ

หมายเหตุ คะแนนเต็ม 4 คะแนน



ใบ งาน  คร ั้งท ี่ 3 (ส ำห ร ับ น ัก เร ียน ก ล ุ่ม ท ี่ม ีโ อ ก าส ใน ก าร เล ือ ก ส ร ้างผ ล งาน )
ให้นักเรียนใช้ความรู้ท่ีเรียนในสัปดาห์นี้ สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยเลือกปฏิบั!ติงาน 1 ช้ิน จ าก 3 ช้ินต่อไปน้ี
1. ปกสมุดโน้ต (Notebook) โดยมีข้อกำหนดด้งนี้

แทรกข้อความศิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลรายละเอียดของปกสมุดโน้ต (เช่น ชื่อนักเรียน 1 ช้ัน 1 วิชา 1 ช่ือ 

อาจารย์ผู้สอน 1 E-mail Address และหมายเลข ICQ เป็นต้น)
- แทรกรูปภาพ อย่างน้อย 3 ภาพ ที่มีความสอดคล้องกับเนื้อหาเอกสาร และ 

อย่างน้อย 1 ใน 3 ภาพ จะต้องมีการกำหนดให้เป็นพื้นหลังของข้อความ 
และเพิ่มความสว่างให้กับภาพนั้นด้วย

- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4 
บันทึกแฟ้มข้อมูลผลงาน โดยใช้ชื่อแฟ้มข้อมูลว่า Note1.Doc

2. ปกรายงาน โดยมีข้อกำหนดด้งนี้
- แทรกข้อความศิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลรายละเอียดของปกรายงาน (เช่น ชื่ออาจารย์ผู้ลอน 1 ช่ือผู้จัดทำ 1 

ช้ัน 1 วิชา 1 ภาคเรียน และปีการสืกษา เป็นต้น)
- แทรกรูปภาพ อย่างน ้อย3 ภาพ ที่มีความสอดคล้องกับเนื้อหาเอกสาร และ 

อย่างน้อย 1 ใน 3 ภาพ จะต้องมีการกำหนดให้เป็นพื้นหลังของข้อความ 
และเพิ่มความสว่างให้กับภาพนั้นด้วย

- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Report1.Doc

3. ใบโฆษณาสินค้า โดยมีข้อกำหนดดังนี้
- แทรก'ข้อความสิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลรายละเอียดของสินค้า และข้อความโฆษณา

แทรกรูปภาพ อย่างน ้อย3 ภาพ ที่มีความสอดคล้องกับเนือหาเอกลาร และ 
อย่างน้อย 1 ใน 3 ภาพ จะต้องมีการกำหนดให้เป็นพื้นหลังของข้อความ 
และเพิ่มความสว่างให้กับภาพนั้นด้วย



กำหนดรูปแบบตัวอักษร (Font, Size 1 style 1 Color)
จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย
เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4 
บันทึกแฟ้มข้อมูลผลงาน โดยใช้ชื่อแฟ้มข้อมูลว่า Present1.DOC



ใบ งาน  คร ั้งท ี่ 3 (ส ำห ร ับ น ัก เร ียน ก ล ุ่ม ท ี่ไม ่ม ีโอ ก าส ใน ก าร เล ือ ก ส ร ้างผ ล งาน )
ให้นักเรียนใช้ความรู้ที่เรียนในสัปดาห์น้ี สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยปฏิบัติงาน ปกรายงาน โดยมีข้อกำหนดด้งนี้
- แทรกข้อความศิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลรายละเอียดของปกรายงาน (เซ่น ชื่ออาจารย์ผู้ลอน 1 ช่ือผู้จัดทำ 1 

ช้ัน 1 วิชา 1 ภาคเรียน และปีการสืกษา เป็นต้น)
- แทรกรูปภาพ อย่างน ้อย3 ภาพ ที่มีความสอดคล้องกับเนื้อหาเอกสาร และ 

อย่างน้อย 1 ใน 3 ภาพ จะต้องมีการกำหนดให้เป็นพื้นหลังของข้อความ 
และเพิ่มความสว่างให้กับภาพนั้นด้วย

- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย
- เอกสารที่นักเรียนลร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Report1.Doc
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เก ณ ฑ ์ก าร ป ร ะ เม ิน ผ ล ง าน  คร ั้งท ี่ 3
จุดประสงค์ของกิจกรรม

1. การแทรกรูปภาพจากภาพตัดปะ (Clip Art) หรอจากแฟ้มข้อมูล (From File)
2. การจัดและตกแต่งรูปภาพ
3. การแทรก'ข้อความติลป๋
4. การจัดและตกแต่งข้อความศิลป๋

ประเด็นประเมิน 4 (ด ีเยี่ยม) 3 (ดี) 2 (พ'อใช้) 1 (ควรปรับปรุง)
ผลงานครบถ้วน - ครบถ้วนและถูกต้องทั้ง 4 - ครบถ้วนและถูกต้อง3 ใน 4 - ครบถ้วนและถูกต้อง 2 ใน 4 -  ครบถ้วนและถูกต้อง
และถูกต้อง จุดประสงค์ จุดประสงค์ จุดประสงค์ น้อยกว่า 2 จุดประสงค์
การปฏิบัติตามข้อ 
กำหนด

- มีการแทรก1ข้อความดีลป๋
-  มีการแทรกรูปภาพ 3 ภาพ
- มีการกำหนดรูปภาพให้เป็นพื้น 

หลังของข้อความ และเพิ่ม 
ความสว่างให้แก่รูปภาพ

- เอกสารมีความยาวไม่น้อยกว่า 
หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลโดยใช้ซ่ือได้ 
อย่างถูกต้อง

- ปฏิบัติ 4 ใน 5 ข้อ - ปฏิบัติ 3 ใน 5 ข้อ -  ปฏิบัติน้อยกว่า 3 ข้อ



ประเด็นประเมิน 4 (ด ีเย ี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
การปรับแต่งย่อ 
หน้า และข้อความ

- มีการกำหนดรูปแบบตัวอักษร 
(Font) ที่เหมาะสมกับเอกสาร

- มีการกำหนดขนาดตัวอักษร 
(Size) ที่เหมาะสมกับเอกสาร

- มีการกำหนดลักษณะของตัว 
อักษร (Style) ที่เหมาะลมกับ 
เอกสาร

- มีการกำหนดสิของตัวอักษร 
(Color) ที่เหมาะลมกับเอกสาร

- มีการจัดรูปแบบย่อหน้า ท่ีเป็น 
ระเบียบเรียบร้อย

- ปฏิบัติ 4 ใน 5 ข้อ -  ปฏิบัติ 3 ใน 5 ข้อ -  ปฏิบัติน้อยกว่า 3 ข้อ

หมายเหตุ คะแนนเต็ม 4 คะแนน



ใบ งาน  ครงท ี่ 4 (ส ำห ร ับ น ัก เร ียน ก ล ุ่ม ท ี่ม ีโ อ ก าส ใน ก าร เล ือ ก ส ร ้างผ ล งาน )
ให้นักเรียนใช้ความรู้ที่เรียนในสัปดาห์นี้ สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยเลือกปฏิบัติงาน 1 ช้ิน จ าก 3 ช้ินต่อไปน้ี
1. ข่าวที่น่าสนใจ โดยมีข ้อกำหนดดังน ี้

แทรกข้อความพิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข่าว หรือบทความจากข่าวท่ีน่าสนใจ
- แทรกรูปภาพ อย่างน ้อย2 ภาพ ที่มีความสอดคล้องกับเนื้อหาข่าว
- กำหนดคอลัมน์แบบ 2 คอลัมน์ให้กับเอกสาร และกำหนดให้มีเล้นแบ่ง 

ระหว่างคอลัมน์ด้วย
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย
- เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ซ่ือแฟ้มข้อมูลว่า News1.Doc

2. ความรู้ที่น่าสนใจ โดยมีข้อกำหนดดังนี้
- แทรกข้อความ?เลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลความรู้ จากนิตยสารหรือหนังสือต่างๆ
- แทรกรูปภาพ อย่างน้อย 2 ภาพ ที่มีความลอดคล้องกับเนื้อหา
- กำหนดคอลัมน์แบบ 2 คอลัมน์ให้กับเอกสาร และกำหนดให้มีเล้นแบ่ง 

ระหว่างคอลัมน์ด้วย
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย
- เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4 

บันทึกแฟ้มข้อมูลผลงาน โดยใช้ซ่ือแฟ้มข้อมูลว่า Magazine1.DOC
3. แผ่นพับ โดยมีข้อกำหนดดังนี้

- แทรก'ข้อความศิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลความรู้จากนิตยสารหรือหนังสือต่างๆ
- แทรกรูปภาพ อย่างน้อย2 ภาพ ที่มีความสอดคล้องกับเนื้อหา
- กำหนดคอลัมน์แบบ 3 คอลัมน์ให้กับเอกสาร และกำหนดให้มีเล้นแบ่ง 

ระหว่างคอลัมน์ พร้อมทังกำหนดหน้ากระดาษแบบแนวนอน (Landscape) 
กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)

- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย
- เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ซ่ือแฟ้มข้อมูลว่า Brochure1.Doc



ใบ งาน  ครั้งที่ 4 (สำหร ับน ัก เร ียน กล ุ่มท ี่ไม ่ม ีโอกาสในการเล ือกสร ้างผลงาน)
ให้นักเรียนใช ้ความร ู้ท ี่เรียนในสัปดาห์นี้ สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยปฏิบ้ติงาน ความรู้ที่'น่าสนใจ โดยมีข ้อกำหนดดังนี้
- แทรก'ข้อความศิลป๋ (WordArt) อย่างน้อย 1 ข้อความ
- พิมพ์ข้อมูลความรู้ จากนิตยสารหรือหนังสือต่างๆ
- แทรกรูปภาพ อย่างน้อย2 ภาพ ที่มีความสอดคล้องกับเนื้อหา
- กำหนดคอลัมน์แบบ 2 คอสัม'นให้กับเอกสาร และกำหนดให้มีเล้นแบ่ง 

ระหว่างคอลัมน์ด้วย
- กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color)
- จัดรูปแบบย่อหน้าให้เป็นระเบียบเรียบร้อย

เอกสารที่นักเรียนสร้างจะต้องมีความยาวไม่น้อยกว่า 1 หน้ากระดาษ A4
- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Magazine1.Doc



ซอกแซกสุดสัปดาห์น คงไม่ดัอง 
ออกไชIดินยํ่าด๊อกท]ทน เพราะทัวทบ้าทีม 
อยากจะฟสื่ยน บรรยากาศ ซอนำท่านผู้ 
ว่านไปซอกแซกอีนเดอร'!นดดูบ้าง

อิน!ตอร'! il 01 ทรอส่ือทันสบ้ยในจอ 
ผู้ที่ชีนฟ่นา ดัดงอนแงฆทลายร้อยล้านคน 
ท่ัวโลกในขณะน

สำทรับนา!แราก็คงจะซแฟนทลาย 
ล้านคน ไปไทนมาไทนยามนมแต่คนพูดท ี
งดอทดอมต่าง า

และอิกทน่นนกัาโครงการ 
อิน!ตอร!นิดตำบลชองท่านนายกฯทักษิณ 
แล้ว!สรจ กิดงจะ!ผมพูนสมาซิกอีกจำนวน 
มาก

แชจริง!อา!ทัดรบทุกทมู่บ้าน!ลย 
ไทมดร้นท่านนายกาครับ กองทุนทมู่บ้าน 
ละล้าน 80 ,000  ทชุบ้าน ยังทำไดั น่าจะ 
ลุยอิน!ดอร!นิดทบู่บ้าน ซะใทัครบ
80 ,0 00  ทปูบ้าน ไชด้วย!ซ่นทัน

ก่อนจะชนไชไกลกว่าน กลับมาคุย 
เรื่องที่ฃึ้บทัว!อาไว่ตีกว่า ดือ ปลาร้า.ดอท 
ดอม

อย่านกว่า!ชนซื่อ!ล่น า ที่ทชุมสาว 
!ฃาซอบ!อามาตั้ง!ชนอี!มล'ส่วนตัวนะครับ 

น!ปีนซื่อจรงของจริง และขายชลา 
ราทันจริง ๆ

ซื่อ!ด็ม!ปีนกามาประกัด ซื่งใครมี 
อิน!ตอ51นิดอยู่กิน'! เะ!ข่าไป!ย่ีอบไดไลย กิ 
ดือ www.plara.vdocall.com

ประกาศขายปลารัาทลายซนิด 
สำทรับสินค้านำร่องขณะนี้มีอยู่ 4 
ประ[ภท ได้แก่ ปลารัากัอบ ปลาร้าผง และ 
ปลารา!!จ่วบองสูด5สมุนไพร ทับนำพริก 
ปลาร้าสำ!รจรูป

ทั่งทบดบรรจุอยู่ในซอง 
อะลูมี!นิยมฟ่อยล์ อย่างดี รับรองไมีมี 
กสื่นรวไทล!ดัดขาด

[จดนารมณ''lu  การนำปลาร้า!ข้าสู่ 
อิน!ตอร!นิดกิ!พอ!ผยแพร่ใทักว่างขวาง 
ออกไชทั่วโลก

คุณ อดิตักด นนทวงษ์ กรรมการ 
ผู้จัดการบริบ้ทวิ!ทศิน บัสปี!นส จำกัด Iจำ 
ของ!ว็บไปีต่ที่ขอ!ริยกย่อ า ว่า “ปลาร้า. 
ดอทดอม” ไท้สับภาษณ' ทนงสือพิมพ์ 
สยามธุรกิจ ที่ดิข่าว!รองบ!ปีนฉบับแรกว่า 

“ ผลการตอบรับดิมาก ทั่ง า ที่!รา 
แพ่ีง!ปิด!วิบไซด'มาแด่ 2 สัปดาทั!ท่านน"

“ เราขาย!ปีนโทล โทลละ 8 1ทริยญ 
ครับ ทรอประมาณ 360  บาท ส่วนขาย 
ปลีกกิซองละ 25 บาท [ท่าทั่น”

!อัา...สินคัาอื่น า เตรียมตัวไว้... 
ปลา[จ่า, กะปิ, บาปลา, ปูเค็ม, ไข่!ดัม, ปู 
ดอง, ทั่งดอง. ต้ักแตนทอด...มีอะไรอีกไทม 
เนย เอามา!ฃัาดอทดอมซะใทัทมด!ลย 
พร้อม า ทัน.

http://www.plara.vdocall.com


ใบใฆัร ับบทหนกในการดำรง 
ช ีว ิตอย ู่ฃองพ ืช ใบไม้เปิบแทส่งปรุง 
อาทารและย ังดอยรับม ือก ับว ิกฤต  
ก ารณ ์ด ่า งา  เซ่น ทาวิธีใทัพืชรอด 
ตายจากอากาศทนาวเย ็น ทรอทำใท้ 
มืนาใช้'อย่างเพียงพอ ใบพืชฆักม ื
ชนาดและรูปร่างแดกด่างกันใป ใทญ่ 
บาง เล ็กย ัาง ทนาบัาง บางบาง 
ซึ่งเราอาจจะทราบฃัอม ูลชองพืช และ 
แทล่งท ี่ม ้นฃี้บอยู่เพ ียงดูจากลักษณะ 
ของใบเท่านบ

ส ะส บ น า
ดันศรนารายณ ์เป ินพ ืซท ี่ขนได  ั

ในเขตที่ไม ่ม ืฝบดกติดต่อกันเป็นเวลา 
ทลายก ัปดาท ์ เพราะยับสะสมนาใว้ใน 
ใบที่ม ืฃนาดใทญ่และทนา

ฑนด่อสุบน]าอากาฟิ
ดันสนพนฟุสกอดจำเป็นดัอง 

เป็นพืชที่ทรทดเพอใทัรอดชีว ิดจาก 
ฤด ูทนาวอันยาวนาน ยันมืใบเล็กๆ 
รูปร ่างคล ้ายเฃมยับพ ้นใบ และ 
เคล ือบด ัวยสารกนนา ใบสนจีงไม่ 
เปียกฝนและทิม

ส ัญ ญ าณ ว ่าขาดน า
กงใบไม้จะพูดไม่ไดั แด่ก็ม ืวิธ ี 

ส ่งก ัญ ญ าณ บอกเทต ุได ้ ใบของดันไซ 
คลาเมน (Cyclamen) จะเที่ยวทัอยลู่ 
ลงเม ื่อย ันชาดนา!เละดินในกระกาง 
แท ้งเป ็นก ัญ ญาณ บ ่งบ ่งบอกว ่า ''ขอ 
นาฉ ับบางส ิ!"

พืชมีm งอ’เทบ ?
พืชควบคุมระดับความซึ่นในใบ  

ด ัวยการปลดปล่อยนาออกจากใบไท  ้
เทล ือคงท ี่ด ัวยกระบวบการดายบา  
(Transpiration) ซ ึ่งจะมองไม่เท ิบดัวย 
ดาเปล่า แด่ท้านำดันไม้มาใส่ใบฤง 
พลาสต ิก และผูกปากฤงใวัก ักครู่จะ 
เท ินทยดนาเกาะเป ็นเม ็ดพราวอยู่กาย  
ในก ุง ทยดป้านคือความสันท ี่พ ืชดาย  
ออกมาทางใบพืชนนเอง



ใบ ไม ้ร ับ บ ท ท น กใน การดำรงช ีว ิต อย ู่ 
?1องพืช ใบไม ้!ป ็บนทล ่งบร ุงอาห ารแล“ย ัง  
ก อ ย ร บ ม ีอ ก บ ว ิก ฦ ต ก าร ณ ์ต ่า ง ๆ  เซ่น ทาว ิธ ี 
ใท ้พ ีซ ร อ ด ด ายจาก อ าก าศ ท น าว เย ็น  ทรือทำ 
ใทไช ีป ้าใข ้อย ่างเพ ียงพอ ใบพ ีซม ้กม ีฃนาดและ 
ร ูป ร ่างน ด ก ต ่างก ัน ไย ่ ใท ณ ์ม ้าง  เล ็ก บ าง  
ทน าบาง บ างม ้าง  ซ ี่ง เราอ าจจะท ราบ ข ้อ ม ูล  
ของพ ีซ และแท ส ่งท ี่ม ้น ข น อย ู่เพ ียงด ูจาก  
ล ักษณ ะของใบเท ่าน ั้น

สะสนนา
ดณ ์ศรนารายณ ์เป ็นพ ีซท ี่ขนได้ในเขตที ่

ไมม่ ีปนดกต ิดต ่อก ันเป ินเวลาทลายล ัปด'าท ์ 
เพ ร าะม้นสะสมนา'ไว!น'ใบที่ชฃบาด'ไทโม่และ

ทนต่อสบฟ็าอากาศ
ด ันสนพ ันธ ุสกอดจำเป ินด ัองเป ็นพ ีซท ี่ 

ทรทดเพ ื่อใก ัรอดช ีว ิดจากฦด ูทนาวอ ันยาว  
นาบ ม้นช'ใบเล็กๆ รปร ่างดล ัายเข ็มน ับพ ัน
ใบ แล:.เค ล ือบ ด ้วยส ารก ัน น า ใบลนจึงไม่ 
เชยกปนและทิมะ

ส ัญ ญ าณ ว ่าซ าดป ้า
กีงใบไม้จะพูดไม่ได้ แด ่ก ็ชว ิธ ีส ่ง  

ส ัญ ญ าณ บอกเทด ุได ้ ใบของด้นไซคลาเมน  
(Cyclamen) จะเท ี่ยวท ัอยล ู่ลงเม ื่อม ้นขาดป ้า 
และด ินในกระกางแท ้งเป ็นส ัญญาณบ ่งบ ่ง 
บอกว่า "ขอป ้าอ ันบางส ิ!"

พซม็เทงอไทม ?
พ ืชควบค ุมระด ับความซนในใบด ้วย  

การย ่ลดป ็ล ่อยป ้าออกจากใบใท ้เทล ือคงท ี ่
ด ้วยกระบวนการคายป ้า (Transpiration) ซี่ง 
จะมองไม ่เท ็บด ้วยตาเปล ่า แต่ก ัานำด้นไม้มา 
ใส ่ในก ุงพลาสต ิก และผูกปากกุงไอ ัส ักครู่จะ 
เท ินทยดป ้าเกาะเป ็นเม ็ดพราวอย ู่กายในก ุง 
ทยดป ้านค ือความซบท ี่พซดายออกมาทางใบ  
พีซป้นเอง



เก ณ ฑ ์ก าร ป ร ะ เม ิน ผ ล ง าน  คร ั้งท ี่ 4
จุดประสงค์ของกิจกรรม

า. การจัดคอลัมน์
2. การปรับความกว้างของคอลัมน์
3. การกำหนดให้มีเลันแบ่งคอลัมน์

ประเด็นประเมิน 4 (ด ืเยี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
ผลงานครบถ้วน 
และถูกต้อง

- ครบถ้วนและถูกต้องทั้ง 3 
จุดประสงค์

- ครบถ้วนและถูกต้อง 2 ใน 3 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 1 ใน 3 
จุดประสงค์

- ไม่ปฏิบัติท้ัง 3 จุดประสงค์

การปฎิบัติตามข้อ
กำหนด

- มีการแทรกข้อความติลบั
- มีการแทรกรูปภาพ 2 ภาพ ท่ีมี 

ความลอดคล้องกับเนื้อหาของ 
เอกสาร

- เอกสารมีความยาวไม่น้อยกว่า 
หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลโดยใช้ชื่อได้ 
อย่างถูกต้อง

- ปฏิบัติ 3 ใน 4 ข้อ - ปฏิบัติ 2 ใน 4 ข้อ -  ปฏิบัติน้อยกว่า 2 ข้อ



ประเด ็นประเม ิน 4 (ดี เยี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
การปรับแต่งย่อ 
หน้า และข้อความ

- มีการกำหนดรูปแบบตัวอักษร 
(Font) ที่เหมาะสมกับเอกสาร

- มีการกำหนดขนาดตัวอักษร 
(Size) ที่เหมาะสมกับเอกสาร

- มีการกำหนดลักษณะของตัว 
อักษร (Style) ที่เหมาะสมกับ 
เอกสาร

- มีการกำหนดสีของตัวอักษร 
(Color) ที่เหมาะสมกับเอกสาร

- มีการจัดรูปแบบย่อหน้า ท่ีเป็น 
ระเบียบเรียบร้อย

- ปฎิบัติ 4 ใน 5 ข้อ - ปฏิบ้ต 3 ใน 5 ข้อ - ปฎิบัติน้อยกว่า 3 ข้อ

หมายเหตุ คะแนนเต็ม 4 คะแนน



ใบ งาน  ครงที่ 5 (ส ์าหร ับน ัก เร ืยนกล ุ่มท ี่ม ีโอกาสในการเส ือกสร ้างผลงาน)
ให้นักเรียนใช้ความรู้ที่เรียนในสัปดาห์นี้ สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยเลือกปฏิบัติงาน1 ช้ิน จ าก 3 ช้ินต่อไปน้ี
1. ตารางสอน โดยมีข้อกำหนดดังนี้

แทรกข้อความศิลป็ (WordArt) อย่างน้อย 1 ข้อความ
- ออกแบบตารางสอนในรูปแบบตารางลงในเอกสาร และจะต้องมีการกำหนด 

การผสานเซลล์ (Merge Cells) อย่างน้อย 2 จุด
- จัดรูปแบบและตกแต่งตารางให้สวยงาม (Fill Color 1 Line Color 1 Line 

Style)
- แทรกรูปภาพ อย่างน้อย 1 ภาพ ที่สอดคล้องกับตารางสอน

กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color) ให้มีความชัดเจนและ 
อ่านข้อความได้ง่าย

- จัดรูปแบบข้อความให้เป็นระเบียบเรียบร้อย
เอกสารที่นักเรียนสร้างจะต้องมีความยาว 1 หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Class'!.Doc
2. ปฏิทินช่วงปีดเทอม (เด ีอนตุลาคม) โดยมีข้อกำหนดดังนี้

แทรกข้อความดืลป็ (WordArt) อย่างน้อย 1 ข้อความ
- ออกแบบปฏิทินช่วงปิดเทอม (เดือนตุลาคม) ในรูปแบบตารางลงในเอกสาร 

และจะต้องมีการกำหนดการผสานเซลล์ (Merge Cells) อย่างน้อย 2 จุด
- จัดรูปแบบและตกแต่งตารางให้สวยงาม (Fill Color 1 Line Color 1 Line 

Style)
แทรกรูปภาพ อย่างน้อย 1 ภาพ ท่ีสอดคล้องกับกิจกรรมในปฏิทิน 
กำหนดรูปแบบตัวอักษร (Font 1 Size 1 Style 1 Color) ให้มีความชัดเจนและ 
อ่านข้อความได้ง่าย

- จัดรูปแบบข้อความให้เป็นระเบียบเรียบร้อย
เอกสารที่นักเรียนสร้างจะต้องมีความยาว 1 หน้ากระดาษ A4 
บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Calendar1.Doc

3. ใบเสร็จรับเงิน โดยมีข้อกำหนดดังนี้
แทรกข้อความศิลป๋ (WordArt) อย่างน้อย 1 ข้อความ

- ออกแบบใบเสร็จรับเงินของร้านค้าแห่งหน่ึง (ให้นักเรียนกำหนดเอง) โดยจัด 
ทำในรูปแบบตาราง และจะต้องมีการกำหนดการผสานเชลล์ (Merge Cells) 
อย่างน้อย 2 จุด



จัดรูปแบบและตกแต่งตารางให้สวยงาม (Fill Color 1 Line Color 1 Line 
Style)
แทรกรูปภาพ อย่างน้อย 1 ภาพ ที่ลอดคล้องกับใบเสร็จรับเงิน 
กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style 1 Color) ให้มีความชัดเจนแล 
อ่านข้อความได้ง่าย
จัดรูปแบบข้อความให้เป็นระเบียบเรียบร้อย
เอกสารที่นักเรียนสร้างจะต้องมีความยาว 1 หน้ากระดาษ A4
บันทึกแฟ้มข้อมูลผลงาน โดยใช้ซ่ือแฟ้มข้อมูลว่า Cash1.Doc



ใบ งาน  ครั้งที่ 5 (สำห ร ับน ัก เร ียน กล ุ่มท ี่ไม ่ม ีโอกาสในการเล ือกสร ้างผลงาน)
ให้นักเรียนใช้ความรู้ที่เรียนในสัปดาห์น้ี สร้างเอกสารด้วยโปรแกรม Microsoft Word 97 

โดยปฏิบัติงาน ป ฏ ิท ิน ช่วงปีดเท'อม (เดือนต ุล าค ม ) โดยม ีข้อกำหนดดงน ี้ 
แทรกข้อความ?เลป๋ (WordArt) อย่างน้อย 1 ข้อความ

- ออกแบบปฏิทินช่วงปิดเทอม (เดือนตุลาคม) ในรูปแบบตารางลงในเอกสาร 
และจะต้องมีการกำหนดการผสานเชลล์ (Merge Cells) อย่างน้อย 2 จุด

- จัดรูปแบบและตกแต่งตารางให้สวยงาม (Fill Color 1 Line Color 1 Line 
Style)

- แทรกรูปภาพ อย่างน้อย 1 ภาพ ท่ีลอดคล้องกับกิจกรรมในปฏิทิน 
กำหนดรูปแบบตัวอักษร (Font 1 Size 1 style , Color) ให้มีความชัดเจนและ 
อ่านข้อความได้ง่าย

- จัดรูปแบบข้อความให้เป็นระเบียบเรียบร้อย
เอกสารที่นักเรียนสร้างจะต้องมีความยาว 1 หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลผลงาน โดยใช้ช่ือแฟ้มข้อมูลว่า Calendar1.DOC
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CUD B oo k  C e n te r  (w w w .cu db o ok .co m )
ทนนพญาไท เขตปทุมวัน กรุงเทพฯ 10330 โทร. 2182345

ได้รับเงินจาก.

ใบรับเงินสด / Cash Receipt

เ ล ข ท  04-30473 
ว ัน ที่ 15 ก.ค. 2544 

....................  หน้า 1

1 0016520 แฟ้มเสนอเซ็น 1 80.00 80.00
2 0016789 ปากกา Pilot 5 10.00 50.00
3 0016985 สมุดทะเบียนรับ A4 2 40.00 80.00
4 0025489 ชุด พลสืกษา 1 120.00 120.00
5 0032145 กระเป๋านักเรียน 1 100.00 100.00
6 0075846 เป้ สาธิตจุฬาฯ 1 100.00 100.00
7 0069875 หนังสือเรียนวิทยาศาสตร์ม.1 30 30.00 900.00
8 0032569 หมวกลูกเสือ 1 30.00 30.00
9 0065478 รองเท้านันยางสืนํ้าตาล 1 150.00 150.00
10 0012345 ผ้าพันคอลูกเสือ 1 32.00 32.00

.................................................ผู้รับเงิน
โปรดรักษาใบรับเงิน;:''..-'เว้กับส้ินค้าเสมอ ก่อนออกจากศูนย์หใ!งลือฯ
สินค้าทุกช้ินท่ีท่านช้ีอ.;.สิว ศูนย์หนังสือฯขอสงวนสิทธ้ิท่ีจะใม่รับเปล่ียนหรือคืน
ใบรับเงินลดต้องมีชื่อแรับเงินทุกครั้ง
เอกสารจะมีผลบังค้บไซ เมื่อมีเลขที่จากคอมพิวเตอร์

http://www.cudbook.com


เกณ ฑ ์การป ระเม ิน ผลงาน  ครั้งที่ 5
จุดประสงค์ของกิจกรรม

1. การแทรกตาราง
2. การผสานเซลล์
3. การกำหนดและปรับแต่งเล้นตาราง
4. การกำหนดและปรับแต่งการแรเงา

ประเด็นประเมิน 4 (ด ีเยี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
ผลงานครบถ้วน 
และถูกต้อง

- ครบถ้วนและถูกต้องท้ัง 4 
จุดประสงค์

- ครบถ้วนและถูกต้อง 3 ใน 4 
จุดประสงค์

-  ครบถ้วนและถูกต้อง 2 ใน 4 
จุดประสงค์

-  ปฏิบัติน้อยกว่า 2 
จุดประสงค์

การปฏิบัติตามข้อ 
กำหนด

- มีการแทรก-ข้อความดีลป๋
- มีการผสานเซลล์อย่างน้อย 2 

จุด
-  มีการจัดรูปแบบและตกแต่ง 

ตาราง (Fill Color 1 Line Color 
1 Line Style)

- มีการแทรกรูปภาพที่สอดคล้อง 
กับข้อมูลในตาราง

- เอกสารมีความยาวไม่น้อยกว่า 
หน้ากระดาษ A4

- บันทึกแฟ้มข้อมูลโดยใช้ชื่อได ้
อย่างถูกต้อง

- ปฏิบัติ 4 ใน 6 ข้อ - ปฏิบัติ 3 ใน 6 ข้อ -  ปฏิบัติน้อยกว่า 3 ข้อ



ประเด็นประเมิน 4 (ด ีเยี่ยม) 3 (ดี) 2 (พอใช้) 1 (ควรปรับปรุง)
การปรับแต่งย่อ 
หน้า และข้อความ

- มีการกำหนดรูปแบบตัวอักษร 
(Font) ที่เหมาะสมกับเอกสาร

- มีการกำหนดขนาดตัวอักษร 
(Size) ที่เหมาะสมกับเอกสาร

- มีการกำหนดลักษณะของตัว 
อักษร (Style) ที่เหมาะสมกับ 
เอกสาร

- มีการกำหนดสีของตัวอักษร 
(Color) ที่เหมาะสมกับเอกสาร

- มีการจัดรูปแบบย่อหน้า ท่ีเป็น 
ระเบียบเรยบร้อย

- ปฏิบัติ 4 ใน 5 ข้อ - ปฏินัติ 3 ใน 5 ข้อ - ปฏิปติน้อยกว่า 3 ข้อ

หมายเหตุ คะแนนเต็ม 4 คะแนน



ภาคผนวก ญ
รูปแบนแฟ้มสะสมผลงานอิเล็กทรอนิกส์



153

ขนตอนการสร้างแฟ้มสะสมผลงานอิเล็กทรอนิกส์

ข้ันท่ี 1 ขั้นเตรียมเครื่องมือและเตรียมผู้เรียน
1. ครูเตรียมอุปกรณ์คอมพิวเตอร์และพัฒนาโปรแกรมสร้างแฟ้มสะสม 

ผลงานอิเล็กทรอนิกส์
2. ครูเตรียมผู้เรียนให้พร้อมลำหรับการสร้างแฟ้มสะสมผลงาน โดย 

ลอนการจัดการไฟล์ และโฟลเดอร์ และลอนการใช้โปรแกรมสร้าง 
แฟ้มสะสมผลงานอิเล็กทรอนิกส์

ข้ันท่ี 2 ขั้นกำหนดเป้าหมาย
1. ครูชี้แจงภาระงานในการจัดทำแฟ้มสะสมผลงาน
2. ครูนำเสนอตัวอย่างแฟ้มผลงานดีเด่น



1 5 4

3. ครูและนักเรียนร่วมสร้างเกณฑ์การประเมินผลงานในแฟ้มผลงานดี 
เด่น โดยครูนำเสนอเกณฑ์การประเมินผลงาน หลังจากน้ันครูและ 
นักเรียนร่วมกันปรับเกณฑ์การประเมินผลงาน 

ข้ันท่ี 3 ขั้นสร้างผลงาน รวบรวมผลงาน และแก้ไขผลงาน
1. กำหนดผลงานที่จะทำการสะสม

1.1 ครูมอบหมายงานให้นักเรียนทำ 1 ชิ้นสำหรับนักเรียนท่ีไม่มี 
โอกาสในการเลือกสร้างผลงาน

1.2 ครูมอบหมายงานให้นักเรียนเลือกทำ 1 ชิ้นจาก 3 ช้ิน สำหรับ 
นักเรียนที่มีโอกาสในการเลือกสร้างผลงาน

2. นักเรียนสร้างผลงานตามกิจกรรมที่กำหนด
3. นักเรียนทำการ Upload ไฟล์ผลงานด้วยโปรแกรมสร้างแฟ้มสะสม 

ผลงานอิเล็กทรอนิกส์’
4. ครูและเพื่อนนักเรียนให้คำแนะนำในผลงานของเพ่ือน
5. นักเรียนปรับและแก้ไขผลงานตามคำแนะนำของครูและเพื่อน 

นักเรียน
6. นักเรียนทำการ Upload ไฟล์ผลงานท่ีทำการปรับปรุงแก้ไข ด้วย 

โปรแกรมสร้างแฟ้มสะสมผลงานอิเล็กทรอนิกส์ โดยไม่ทับกับไฟล์ 
เดิม

ข้ันท่ี 4 ขั้นคัดเลือกผลงาน และสร้างแฟ้มผลงานดีเด่น
1. นักเรียนคัดเลือกผลงานในแต่ละสัปดาห์ เพื่อนำมาสร้างแฟ้มผล 

งานดีเด่น
2. นักเรียนสร้างแฟ้มผลงานดีเด่นด้วยโปรแกรมสร้างแฟ้มสะสมผลงาน 

อิเล็กทรอนิกส์
ข้ันท่ี 5 ข้ันสะท้อนความรู้สึกต่อผลงาน

นักเรียนกรอกข้อความสะท้อนความรู้สึกที่มีต่อผลงานที่ตนเองเลือก 
ลงในแบบแสดงความคิดเห็นของนักเรียนที่มีต่อผลงาน ด้วยโปรแกรมสร้างแฟ้มละลมผลงาน 
อิเล็กทรอนิกส์
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ข้ันท่ี 6 ขั้นประเมินแฟ้มผลงานดีเด่น
ครูประเมินแฟ้มผลงานดีเด่น โดยประเมินผลงานแต่ละชิ้นตามเกณฑ์ที่ 

ครูและนักเรียนรวมกันสร้าง จากนั้นทำการหาคะแนนรวม

ข้ันท่ี 7 ขั้นประชาสัมพันธ์แฟ้มผลงานดีเด่น
ครูประชาสัมพันธ์ให้คณาจารย์ และนักเรียนในระดับข้ันอ่ืนๆ เข้าซมผล

งานบนอินเตอร์เน็ต

แบบแสดงความคิดเห็นของนักเรียนที่ม ีต ่อผลงานเรื่อง________________

1. นักเรียนตัดสินใจเลือกผลงานชิ้นนี้เพื่อเก็บสะสมในแฟ้มละลมผลงาน เพราะว่า__________
2. นักเรียนใช้เวลาทำผลงานชิ้นนี้นานเท่าใด________________
3. นักเรียนมีปัญหาอะไรบ้าง ในการทำผลงานชิ้นนี__________________
4. นักเรียนแก้ปัญหานั้นอย่างไร________________
5. ผลงานชิ้นนี้มีจุดเด่นและจุดด้อยอย่างไร_________________
6. นักเรียนมีความคิดเห็นและรู้สึกอย่างไรต่อผลงานชิ้นนี_้________ !__________



ภ า ค ผ น ว ก  ฎ

โ ป ร แ ก ร ม ส ร ้า ง แ ฟ ้ม ส ะ ส ม ผ ล ง า น อ ิเ ล ็ก ท ร อ น ิก ส ์
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หน้าเข้าส่ระบบ

ตัวอย่าง 3 ตัวอย่างต่อสัปดาห์ สำหรับนักเรียนกลุ่มท่ีมีอิสระในการสร้างผลงาน
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ต ัว อ ย ่า ง  1 ต ัว อ ย ่า ง ต ่อ ส ัป ด า ห ์ ส ำ ห ร ับ น ัก เ ร ย น ก ล ุ่ม ท ี่ไ ม ่ม ีอ ิส ร ะ ใ น ก า ร ส ร ้า ง ผ ล ง า น

ผลงานของเพื่อน : รายซื่อนักเรียน
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ผ ล ง า น ข อ ง เ พ ื่อ น  : แ ฟ ้ม ส ะ ส ม ผ ล ง า น ข อ ง เ พ ื่อ น

ผลงานของเพื่อน : ดูผลงานของเพื่อน และให้คำแนะนำ



แฟ้มสะสมผลงานชัวคราวของนักเรียน : สร้างโฟลเดอร์ผลงาน ลบโฟลเดอร์ผลงาน และเลือก 
โฟลเดอร์ผลงาน
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แฟ้มสะสมผลงานชั่วคราวของนักเรียน : Upload ไฟล์ผลงาน
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แ ฟ ้ม ส ะ ล ม ผ ล ง า น ด ีเ ด ่น  : ส ร ้า ง แ ฟ ้ม ส ะ ส ม ผ ล ง า น ด ีเ ด ่น
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แฟ้มละสมผลงานดีเด่น : สร้างแฟ้มสะสมผลงานดีเด่นหน้าประว้ติส่วนตัว

แฟ้มสะสมผลงานดีเด่น : สร้างหน้ารวบรวมผลงาน
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แฟ้มสะสมผลงานดีเด่น : เลือกผลงาน และแสดงความคิดเห็นที่มีต่อผลงานของตนเอง

แฟ้มสะสมผลงานดีเด่น: หน้าแรก
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แฟ้มละลมผลงานดีเด่น : หน้าประ'ว้เติส่วนตัว
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แฟ้มสะสมผลงานดีเด่น : แบบแสดงความคิดเห็นที่มีต่อผลงานของตนเอง

แฟ้มสะสมผลงานดีเด่น : คำแนะนำของครูและเพ่ือน
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นายประกอบ กรณีกิจ เกิดวันท่ี 29 มิถุนายน 2519 ท่ีอำ๓ อหนองใหญ่ จังหวัด 
ชลบุรี สำเร็จการศึกษาระดับปรญญาตรี หลักสูตรครุศาลตรบัณฑิต สาขาวิชาการศึกษานอก 
ระบบโรงเรียน วิชาเอกคอมทิวเตอร์ศึกษา ภาควิชาการศึกษานอกระบบโรงเรียน คณะ 
ครุศาลตรี จุฬาลงกรณ์มหาวิทยาลัย ในปีการศึกษา 2540 และเข้าศึกษาต่อในหลักสูตร 
ครุศาลตรมหาบัณฑิต สาขาวิชาโสตทัศนศึกษา ภาควิชาโสตทัศนศึกษา คณะครุศาลตรี 
จุฬาลงกรณ์มหาวิทยาลัย เมื่อปีการศึกษา 2542 ปัจจุบันเป็นอาจารย์ประจำหมวดวิชา 
คอมพิวเตอร์ โรงเรียนสาธิตจุฬาลงกรณ์มหาวิทยาลัย ฝ่ายมัธยม
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